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≤¥ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



 ∫Half Section ŸUDI�« nB½
 sOFÞU
 sO¹u²�LÐ r�−�« lD
 qO�ð r²¹ YOŠ  ̈s¹—u×� ‰uŠ WKŁUL²L�« ÂU�ł_« w� Î…œUŽ ŸuM�« «c¼ Âb�²�¹

Æ©∏≠≤® qJA�« w� UL� s¹b�UF²�

 lD
 Èu²��

w�U�√

 lD
 Èu²��

w³½Uł

©∏≠≤® qJA�«

©π≠≤® qJA�«

 r�−�« e�d� w� ÊUFÞUI²¹ w³½UłË w�U�√ sOFÞU
 sO¹u²�LÐ tFD
 qO�ð bFÐ r�−�« sO³¹ ©π≠≤® qJA�«Ë

ÆŸuDIL�« V¹dI�« ¡e−�« WŠ«“≈ bFÐ

≤μ  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



 ULNMOÐ qBH¹ jI�� tHB½Ë  ŸUD
 tHB½ w³½U−�« jI�L�«Ë ¨Îö�U� w�U�_« jI�L�« ©±∞≠≤® qJA�« sOÐ 

ÆÎö�U� rÝdO� wI�_« jI�L�« U�√ ¨Íe�d� jš

©±∞≠≤® qJA�«

WEŠö�
 wHš U� dNE¹ ŸUDI�« nB½ Ê√ YOŠ WKŁUL²L�« ÂU�ł_« w� WFDI²L�« ◊uD��« rÝ— sŽ ¡UMG²Ýô« sJL¹

ÆjI�LK� dšü« nBM�« w�

≤∂ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



∫UN²�ôœË lDI�« ◊uDš
 ? ÎUIÐUÝ XLKFð UL� ? rÝd¹ YOŠ ¨lÞUI�« Èu²�L�« —U�� b¹b×²� j
U�L�« bŠ« vKŽ lDI�« ◊uDš rÝdð

 V½U−Ð V²J¹Ë ¨ŸuDIL�« jI�L�« v�≈ Ê«dOA¹ sOLNÝ tO�dÞ bMŽ rÝd¹ rK� ©∞[∑ ≠ ∞[μ® pOLÝ wzd� j�Ð

Æ©±±≠≤® qJA�« w� UL� ¨a�≈ ì ¨ » – » ¨ √ – √ q¦� ŸUDI�« rÝ≈ vKŽ ‰b¹ e�— rNÝ q�

lDI�« ◊uDš ∫©±±≠≤® qJA�«

∫©dOAN²�«® qOKE²�« ◊uDš
 ◊uDš vL�ð WOzUA½≈ ◊uD�Ð WKKE� U¼—UNþ≈ w¼ lÞUI�« Èu²�L�« UNÐ dL¹ w²�« ÕuD��« eOOL²� WF³²L�« …bŽUI�«

∫wK¹ ULÐ eOL²¹Ë ¨©±≤≠≤® qJA�« w� UL� UNM� Î«bŠ«Ë ÎUŽu½ bL²F½ ·uÝË Ÿ«u½√ …bŽ w¼Ë ¨qOKE²�«

Æ©2H® rKIÐ rÝdð WLOI²�� WKB²� WFO�— ◊uDš  ±

Æ¡«uÝ ÌbŠ vKŽ —U�O�« Ë√ 5LO�« vKŽ ©
o
¥μ® W¹Ë«“ vKŽ WKzU� ◊uDš  ≤

Æ ŸuDI*« `D��« WŠU�� V�Š rK� ©¥≠≤® 5Ð ÕË«d²ðË ¨WLE²M� UNMOÐ  U�U�*«  ≥

ÆŸuDI*« `D��« q¦9 w²�« WIDM*« œËbŠ sŽ hIMð ôË b¹eð ô  ¥

qOKE²�« ◊uDš ∫©±≤≠≤® qJA�«

 ∫ qOKE²�« bMŽ wK¹ U� …UŽ«d� V−¹Ë «c¼

 rÝd�«  w� UL� 5ð—ËU−²� 5²FDI� f�UF²� qOKEð Â«b�²Ý«Ë ¨…bŠ«u�«  WFDIK� bŠ«Ë ÌÁU&UÐ  qOKE²�«  ±

ÆwFOL−²�«

≤∑  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



Æ©
o
¥μ W¹Ë«eÐ WKzU� ŸuDI*« `D��« œËbŠ ÊuJð U�bMŽ® W�Uš  ôUŠ w� 

o
∂∞ Ë√ 

o
≥∞ v�≈ 

o
¥μ W¹Ë«e�« dOOGð  ≤

 ©WFDI²*«® WOH�*« ◊uD)« U�√ Æe�d*« jš rÝ— sJ1 ULMOÐ ¨qOKE²�« ◊uDš X% WOzd� ◊uDš rÝdð ô  ≥

Æ…—œU½  ôUŠ w� ô≈ rÝdð ö�

Æt×D�� Ì“«u� qJAÐ tFD
 - «–≈ ©W¹uI²�« lK{® VBF�« qKE¹ô  ¥

ÆqOKE²�« ◊uDš s� Ã–ULM�« iFÐ  5³¹ ©±≥≠≤® qJA�«Ë ¨UNÐ W�Uš qOKEð ◊uDš …œU� qJ�  μ

W½UÝdšb¹bŠvBŠ

e½ËdÐ ¨”U×½–ôu�VAš

qOKE²�« Ã–UL½ ∫©±≥≠≤® qJA�«

≤∏ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©±≠≤® ‰U¦�    ∫WK¦�√

ÎUO³½Uł ÎUŽUD
ÎUO�U�√ ÎUŽUD


ÎUOI�√ ÎUDI��

≤π  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©≤≠≤® ‰U¦�

ÎUO³½Uł ÎUŽUD
ÎUO�U�√ ÎUŽUD


ÎUOI�√ ÎUŽUD


≥∞ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©≥≠≤® ‰U¦�

ÎUO³½Uł ÎUŽUD
ÎUO�U�√ ÎUŽUD


ÎUOI�√ ÎUŽUD


≥±  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©¥≠≤® ‰U¦�

d�¹√ w�U�√ ŸUD
 nB½

ÎUOI�√ ÎUDI��

sL¹√ w³½Uł ŸUD
 nB½

 lD
 «–≈ VBF�« Ê√ kŠô

qKE¹ ô t½S� t×DÝ …«“«uLÐ

VBŽ

VBŽ

”

”

≥≤ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



∫wðü« ÕU²HL�« w	 UL� »uKDL�« rÝ—« ∫s¹—ULð
ŸUD
 nB½ rÝ—                         q�U� ŸUD
 rÝ—        jI�� rÝ—     

©±® s¹d9

©≤® s¹d9

≥≥  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©≥® s¹d9

©¥® s¹d9

2 x  ø20

≥¥ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©μ® s¹d9

©∂® s¹d9

≥μ  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©∑® s¹d9

©∏® s¹d9

≥∂ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©π® s¹d9

21

16

©±∞® s¹d9

≥∑  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©±±® s¹d9

©±≤® s¹d9

≥∏ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©±≥® s¹d9

©±¥® s¹d9

≥π  U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



©±μ® s¹d9

©±∂® s¹d9

¥∞ U??ŽU??D??I??�« r????Ý— ∫W??O??½U??¦??�« …b???Šu???�«



¥± …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

≥≥…b?????Šu�«…d???(« b???O�UÐ r??Ýd�«

…bŠu�« ·«b¼√
ÆtðU�«b�²Ý«Ë d(« rÝd�« WOL¼√ vKŽ ·dF²�«

Æ…d(« bO�UÐ rÝdK� `O×� qJAÐ ÁU×L*«Ë rKI�« ‰ULF²Ý«

Æ…d(« bO�UÐ wŽUMB�« rÝd�«  UŠu� cOHMð s� sJL²�«



¥≤…d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

W�bI�
 WI¹dÞ uN� Æ”bMNL�« Ë√ rLBL�« Ë√ ÂUÝd�« UNÐ l²L²¹ Ê√ V−¹ w²�«  «—UNL�« r¼√ s� …d×�« bO�UÐ rÝd�« d³²F¹

 ÂUÝd�« sJLð …¡UHJÐ rÝd�« WŠu� jOD�²� …“U²L� WI¹dÞ d³²F¹ p�c�Ë r¼dOžË sOOŽUMB�« sOÐ —UJ�_« ‰œU³²� WF¹dÝ

 s� sJL²¹Ë qC�√ …—uBÐ t²LÝd� jOD�²�« lOD²�¹ d×�« rÝd�UÐ √b³¹ Íc�« ÂUÝd�U� Î̈«bOIFð d¦�√ WLÝ— ÃU²½≈ s�

 «c¼Ë ¨`{«ËË l¹dÝ qJAÐ —UJ�_« sŽ dO³F²�« w� bN−�«Ë X
u�« dB²�ð WI¹dÞ wN� ¨«c� Æq
√ X
uÐ U¼“U−½≈

 sO³¹  ©3≠1® qJA�«Ë ÆUN²�ULÝË UN�«uÞ√ VÝUMð w� W×O×� rÝd�« ◊uDš ÊuJ²� Õu{u�«Ë W¹UMF�«  VKD²¹

Æ…d×�« bO�UÐ ÎU�uÝd� XOÐ jD�L� ÎUł–uL½

Âu½ W�dž

Âu½ W�dž

ÂULŠ

a³D�…dHÝ

WAOF�

Êe��

…d×�« bO�UÐ ÎU�uÝd� XOÐ jD�� ∫©±≠≥® qJA�«



¥≥ …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

…d(« bO�UÐ rÝd�« WOL¼√
∫…d×�« bO�UÐ rÝd�« Â«b�²Ý« wŽb²�ð w²�«  ôU×�« iFÐ V�UD�« Íe¹eŽ pO�≈

ÆUMOF� UŽu{u� h�ð WOLKŽ Ë√ WOM� …dÞUš Ë√ …dJ� sŽ dO³F²�«  ±

ÆdOB
 X
Ë w� 5F� rÝ— cOHMð  ≤

 Æ5F� rÝ— cOHMð Vłu²�ð W¹—«dD{≈  ôUŠ w� rÝd�«  «Ëœ√ d�uð ÂbŽ  ≥

Æ 5F� “UNł qLŽ WOHOJ� w×O{u²�« rÝd�«  ¥

 ÆÈdš√ ¡«eł√ v�≈ W³�½ U� “UNł ¡«eł√ iFÐ W�dŠ sŽ WLłUM�«  «dOG²�« l³²ð  μ

 v�≈ qÝd¹Ë …d(« bO�UÐ q¹bF²�« rÝdO� ¨cOHM²K� t�UÝ—≈ o³Ý rÝd�« s� ¡«eł√ vKŽ Wz—UD�«  ö¹bF²�«  ∂

Æ‰uÞ√ U²
Ë ‚dG²�¹ ©bFÐ ULO�®  «Ëœ_UÐ tLÝ— ULMOÐ ¨o×KL� qGA*«

Æ…dO¦J�« ‚dH�« 5Ð U� W½UOB�«  UOKLŽ lÐU²ð qON�²�  ∑

…d(« bO�UÐ rÝdK� W�“ö�«  «Ëœ_«
Æ©ö¦� HB rK
® ◊uD)« Ÿ«u½√ lOLł rÝ— t²DÝ«uÐ sJ1 bOł ’U�— rK
  ±

Æ…bOłË W¹dÞ …U×2  ≤

 ÆW¹d²�Ëe¹¬  UJ³ý Ë√ ¨ UFÐd� ‚—Ë UNO� U0 rÝ— ‚«—Ë√  ≥

 …d(« bO�UÐ rÝd�« bMŽ rKI�« Â«b�²Ýô W�UF�« bŽ«uI�« iFÐ
 ôË  r??Ýd??�«  ¡U??M??Ł√  V×�¹  YO×Ð  rKI�«  p�1  ±

Æl�b¹

 sŽ 
o
∑μ – 

o
∂∞ W¹Ë«eÐ rÝd�« ¡UMŁ√ rKI�« qO1  ≤

 ÆW
—u�« `DÝ

 f½U& vKŽ ‰uB×K� rÝd�« ¡UMŁ√  rKI�«  — ÒËb
Ô
¹  ≥

 Æj)« W�ULÝ w�

©
o
∑∞≠

o
∂∞®

rKI�« V×Ý ÁU&«

rÝd�« W
—Ë vKŽ rKI�« l{Ë ∫©≤≠≥® qJA�«



¥¥…d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

…d(« bO�UÐ rÝd�«  UOÝUÝ√

 WLOI²�*« ◊uD)« rÝ—      ∫ÎôË√  
 …dOBI�« U�√ ¨WK¹uÞ ÊuJð b
Ë …dOB
 ÊuJð b
 WLOI²�L�« ◊uD��«

 p¹d×ð sJLO� ÎUO³�½ WK¹uD�« ULMOÐ bŽU��« XO³¦ðË mÝd�« p¹d×²Ð rÝd²�

  ∫wK¹ U� v�≈ WLOI²�L�« ◊uD��« rÝ— rO�Ið sJL¹Ë ÆmÝd�« l� bŽU��«

Æ5LO�« v�≈ —U�O�« s� ¡b³�« `BM¹ wI�√ jš rÝd�  ± 

Æ©≥≠≥® qJA�« w� UL�   

©≥≠≥® qJA�«

ÆqHÝ_« v�≈ vKŽ_« s� ¡b³�« `BM¹ wÝ√— jš rÝd�  ≤

Æ©¥≠≥® qJA�« w� UL�   

©¥≠≥® qJA�«

Æ©μ≠≥®qJý wÝ√— Ë√ wI�√ t½Q� j)« rÝd¹ YO×Ð W
—u�« qOO9 sJ1 qzU� jš rÝd�  ≥

©μ≠≥® qJA�«



¥μ …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

 dz«Ëb�« rÝ—     ∫UO½UŁ  
∫UL¼Ë sO²I¹dÞ ÕdA½ ·uÝË UNŽU³ð≈ sJL¹ WI¹dÞ s� d¦�√ „UM¼ …d×�« bO�UÐ …dz«b�« rÝd�

∫WOðô«  «uD)« l³²½ YOŠ lÐd*« qš«œ  ±
Æ©√≠∂≠≥®qJA�« w� UL� tŽö{√ nBM½ rŁ …dz«b�« dDI� U¹ËU�� tFK{ ‰uÞ ÊuJ¹ YO×Ð UFÐd� rÝd½  √  

 UL� …dz«b�« jO×� `�ö� œb% e�d*« s� W²ÐUŁ W�U�� vKŽ WHOHš UÝ«u
√ UNOKŽ lC½Ë lÐd*« ÍdD
 rÝd½  »

Æ©»≠∂≠≥®qJA�« w�

≠≥®qJA�« w� UL� ¨s¹dDI�« vKŽ WHOH)« ”«u
ô«Ë UNðUHB²M� w� lÐd*« Ÿö{√ f9 w²�« …dz«b�« rÝd½  ?ł

Æ©?ł≠∂

√ ≠ ∂ ≠ ≥» ≠ ∂ ≠ ≥?ł ≠ ∂ ≠ ≥

lÐdL�« qš«œ …dz«b�« rÝ— ∫©∂≠≥® qJA�«

∫wK¹ UL� —ËU;« WDÝ«uÐ  ≤
Æ©√≠∑≠≥®qJA�« w� UL� ÍœuLF�«Ë wI�_« dþUM²�« Í—u×� rÝd½  √  

 UNM� q� ÍËU�¹ ô«uÞ√ UNFOLł—ËU;« vKŽ —bI½Ë 5²N'« vKŽ
 o

¥μ W¹Ë«eÐ ÊöO1 s¹dš¬ s¹—u×� rÝd½  »

Æ©»≠∑≠≥®qJA�« w� UL� WÐuKD*« …dz«b�« dD
 nB½

 WÐuKD*« …dz«b�« Z²M²�  U¼dNE½ rŁ WÐuKD*« …dz«b�« `�ö� œb% WHOHš UÝ«u
√ rÝd½  UFÞUI²�« Ác¼ s�  ?ł

Æ©?ł≠∑≠≥®qJA�« w� UL�



¥∂…d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

√ ≠ ∑ ≠ ≥» ≠ ∑ ≠ ≥?ł ≠ ∑ ≠ ≥

—ËU×L�« WDÝ«uÐ …dz«b�« rÝ— ∫©∑≠≥® qJA�«

”«u�_« rÝ—      ∫ÎU¦�UŁ  
Æ”uI�« rÝ— WI¹dÞ  rNH� ©∏≠≥®qJA�« WFÐU²� sJL¹Ë dz«Ëb�« rÝ— WI¹dÞ fHMÐ  ”«u
_« rÝ— r²¹

√ ≠ ∏ ≠ ≥» ≠ ∏ ≠ ≥?ł ≠ ∏ ≠ ≥

Ídz«b�« ”uI�« rÝ— ∫©∏≠≥® qJA�«

∫…d(« bO�UÐ rÝd�« bMŽ UNðUŽ«d� V−¹  UEŠö� 

 rÝdK� t½UIð≈ œ«œ“« ULK� ¡Ëb¼ d¦�√ ÂUÝd�« »UBŽ√ X½U� ULKJ� »UBŽ_« ¡ËbNÐ ÂUÝd�« vK×²¹ Ê√ V−¹  ±

Æ`O×� fJF�«Ë

ÆWKB²�Ë WO�U²²� …dOG� lDI� ÎUO³�½ WK¹uD�« ◊uD)« rÝdð  ≤

Æ©π≠≥® qJý ¨œUFÐ_« b¹b×²� rK
 Ë√ W
—Ë s� Ì¡eł Â«b�²ÝU� dEM�UÐ œUFÐ_« 5Ð VÝUM²�« W�ËU×�  ≥

Æ U×KDB*«Ë “u�d�«Ë œUFÐ_U� rÝdK� W�“ö�« WO×O{u²�«  U½UO³�« l{Ë  ¥



¥∑ …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

Æ…d(« bO�UÐ rÝd�« bMŽ UNðUH�«u0 ◊uD)« Ÿ«u½√ …UŽ«d� V−¹  μ

ÆrÝd�« W
—Ë vKŽ Ë√ lÐU�_« 5Ð  jGC¹ ôË bOK� W×¹d� WI¹dDÐ rKI�« p�1  ∂

                            

©π≠≥® qJA�«



¥∏…d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

WK¦�√



¥π …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

s¹—ULð
Æ UFÐd� ‚—Ë vKŽ …d×�« bO�UÐ ©μ≠±® s� s¹—UL²�« rÝ—√

o
≥∞ – 

o
∂∞ YK¦�

o
¥μ YK¦�

…dzUÞ j
U��

©±® s¹d9

©≤® s¹d9



μ∞…d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«

Ê«bM��«

WLzU
 W¹Ë«“

…—uDI� WMŠUý

©μ® s¹d9

©≥® s¹d9

©¥® s¹d9



©tD�U��Ë —uEM�®  ©∂® s¹d9

μ± …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«



WO½Ëd²J�« WŠu�    ©∑® s¹d9

μ≤…d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«



©∏® s¹d9

©π® s¹d9

μ≥ …d??(«  bO�UÐ  r??Ýd??�«  ∫W??¦??�U??¦??�«  …b??Šu??�«



μ¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

¥¥…b?????Šu�«œU�uðË_UÐ  rÝd� «

…bŠu�« ·«b¼√
Æ…œbF²� ‚dDÐË l¹dÝË oO
œ qJAÐ  U�uÝd�« “U$« w� t�«b�²Ý«Ë œU�uðË_« Z�U½dÐ qOGAð s� sJL²�«

Æ»uÝU(UÐ rÝd�«Ë  «Ëœ_UÐ ÍËbO�« rÝd�« 5Ð ‚dH�« f*

ÆrÝd�UÐ W
öŽ UN� Èdš√ Z�«dÐ Â«b�²Ý«Ë qOGA²�« s� sJL²K� V�UD�«  «—b
 WOLMð



μμ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

œU�uðË_« qOGAð ∫‰Ë_« ”—b�«
 ◊uDš rÝd� ¢j��« rÝ—¢ d�_« oO³D²� dýRL�« Â«b�²Ý« ¨œU�uðË√ qOGAð WOHO� ”—b�« «c¼ w� rKF²MÝ

ÆœU�uðË√ s� ÃËd��«Ë tLÝdÐ UML
 U� kHŠË ¨qOD²�L�« rÝ—Ë ¨WMOF�

 v�≈ qI²½≈  rŁ ¨“ËbM¹Ë w� ¢Start  ¢√bÐ≈  —e�«  vKŽ dIM�UÐ  œU�uðË√ qGý

 vKŽ  dI½«Ë  ¢AutoCAD 2002¢  WŽuL−L�«  v�≈  rŁ  ¢Programs¢Z�«d³�«

 vKŽ ≤∞∞≤ œU�uðË√ W½uI¹√ ‚u� ÎUłËœe� Î«dI½ dI½√ Ë√ Æ¢AutoCAD 2002¢

 ÆV²JL�« `DÝ

 œU�uðË√ W½uI¹√ ∫©±≠¥® qJý  

V²JL�« `DÝ vKŽ

 jGC�UÐ ÎUO�UŠ UNIKž√ ÆAutoCAD 2002Today —«u×�« lÐd�Ø …c�UM�« p� dNE²Ý sO²IÐU��« sO²�U×�« w�

Æ©≤≠¥® qJý ¨œU�uðË√ ©Z�U½dÐ® WýUý Ëb³ð UN²E×�Ë ÆvMLO�«Ë W¹uKF�« UN²¹Ë«“ w� œułuL�«  vKŽ

WOÝUOI�« WLzUI�« wÝUOI�«  «Ëœ_« j¹dý hzUB��«  «Ëœ√ j¹dý

q¹bF²�«  «Ëœ√ j¹dý

W�U×�« j¹dý

rÝd�«  «Ëœ√ j¹dý

rÝd�« dýR� rÝd�« …c�U½

WM¹UFL�«  UÐu³ð

d�«Ë_« …c�U½

≤∞∞≤ œU�uðË√ Z�U½d³� WOIO³D²�« WNł«u�« ∫©≤≠¥® qJA�«



μ∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫WO�U²�« W�UN�«  U½uJL�« s� Î«œbŽ Íu×ð ©rÝd�« WýUý® œU�uðË√ Z�U½d³� WOIO³D²�« WNł«u�« Ê√ WEŠö� UMMJL¹

ÆUL¼dOžË Edit d¹d% WLzU
Ë File nK� WLzUI� ¨WOÝUOI�« “ËbM¹Ë ©Menus® rz«u
   ±

 ÆWOÝUOI�« ©Toolbar®  «Ëœ_« j¹dý   ≤

 ÆModify Toolbar q¹bF²�«  «Ëœ√ j¹dýË Draw Toolbar rÝd�«  «Ëœ√ j¹dA� ¨WHK²��  «Ëœ√ WÞdý√   ≥

 W½uI¹√ œułË kŠô ÆUNKš«œ rÝd�« r²¹ ©w²�« WŠU�*«® WýUý w¼Ë ¨©Drawing Window® rÝd�« …c�U½   ¥

Æ©UCS Icon®  UOŁ«bŠù« ÂUE½

 V¹u³²�« ÊuJ¹ Æw�U(« rÝdK� WHK²��  UM¹UF� v�≈ ‰u�u�« s� pMJ9 w²�« WM¹UF*« ©Tabs®  U³¹u³ð  μ

ÆDefault w{«d²�ù« V¹u³²�« u¼ ©Model® ¢Ã–u/¢

Æd�«Ë_« WÐU²J� dDÝ_« s� œËb×� œbŽ s� W½uJ� …dOG� …c�U½ w¼Ë ©Command window® d�«Ë_« …c�U½  ∂

ÆÎö¦� rÝd�« dýR� l
u�  UOŁ«bŠ≈ V
«dð Ê√ pMJ1 YOŠ ©Status bar® W�U(« j¹dý   ∑

 œU�uðË√ w	 d�_« cOHMð
 WOÝbM¼ WOKLŽ W¹√  cOHM²�  œU�uðË√ d�«Ë√ v�≈ ÃU²×ð p½S� ¨rÝd�« WýUý v�≈ qšbðË œU�uðË√ qGAð U�bMŽ

 rÝ—¢ d�_« Â«b�²Ý« pOKŽ ¨jš rÝdÐ X³ž— «–≈ ¨‰U¦L� ÆW�uÝdL�« d�UMF�« vKŽ q¹bFð Ë√ Ìu×�Ë rÝ— s�

 œU�uðË√ WýUý vKŽ W�uÝd� d�UMŽ u×� X³ž— «–≈ tÐUA� ÌqJAÐË ÆW¹UNM�«Ë W¹«b³�« w²DI½ b¹b×ð rŁ  Line¢jš

 ÆU¼u×L²Ý w²�« d�UMF�« —UO²š« rŁ  Erase ¢ u×� ¢d�_« v�≈ qšbð Ê√ pOKF�

 œU�uðË√ w	 d�«Ë_« ‰Ušœ≈
œU�uðË√ w� d�«Ë_« ‰Ušœù W�Oz— ‚dÞ ÀöŁ błuð

 w� d�_« rÝ« dNE¹ YOŠ ¨`OðUH*« WŠu� Â«b�²ÝUÐ d�_« WÐU²�   ±

Æd�«Ë_« …c�U½

ÆWOÝUOI�« WLzUI�« s� d�_« ¡UI²½«   ≤

Æ «Ëœ_« j¹dý s� d�_« ¡UI²½«   ≥

∫WEŠö�
 rz«uI�«  w�  œU�uðË√  d�«Ë√  q�  d�u²ð  ô

 b& b
 qÐ  «Ëœ_« WÞdý√ w� v²Š ôË

 ÎUOÐU²� d�Ë_« …c�U½ sL{ UNCFÐ cOHMð Ê√

 ÆqNÝ_« u¼

 ∫w�U²�« u×M�« vKŽ d�_« p� V²JMÝ ¨d�«Ë_« …c�U½ w� d�_« WÐU²	 pM� VKÞ «–≈
 ¨‰Ušœù« ÕU²H� vKŽ jG{« rŁ QSAVE  d�«Ë_« …c�U½ w� V²�« nKL�« kH×� Í√® QSAVE  ∫V²�√

 ©  e�d�UÐ Îö³I²�� UN� e�dMÝ …dOš_« Ác¼Ë



μ∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ∫w�U²�« u×M�« vKŽ d�_« p� V²JMÝ WO�Ozd�« WLzUI�« s� d�_« ¡UI²½« pM� UM³KÞ «–≈
Æ©W�b�ML�« WLzUI�« s� Save ¢kHŠ¢ d²š« rŁ WO�Ozd�« WLzUI�« s� File ¢nKL�«¢ d²š« Í√®  File>Save d²š«

 ∫w�U²�« u×M�« vKŽ d�_« p� V²JMÝ  «Ëœ_« j¹dý s� d�_« ¡UI²½« pM� UM³KÞ «–≈
ÆSave ¢kHŠ¢ W½uI¹√ d²š«

∫q�UA*« s� ÃËd)«
  «Ëœ_« W�dF� ÊS� p�c�Ë ¨ÎULz«œ ¡UDš√ »UJð—« v�≈ œU�uðË√ w� rÝdK� t²Ý—UL� bMŽ Âb�²�L�« ÷dF²¹

∫W�uN�Ð UNMŽ lł«d²�« vKŽ ÁbŽU�ð WO�U²�«

  ¨`OðUH*« WŠu� w� ©—U�O�« v�≈ ÎULNÝ Íu×¹Ë ‰Ušœù« ÕU²H� vKŽ√ błu¹® Backspace lł«d²�« ÕU²H�  ±

 ÆœU�uðË√ d�«Ë√ …c�U½ w� WOÐU²J�« ¡UDš_« sŽ lł«d²�« vKŽ ÕU²H*« Ác¼ ‰ULF²Ý« bŽU�¹ ∫©≥≠¥® qJý

 ÕU²H� vKŽ jGCð Ê√ q³
 QD��« «c¼ v�≈ XN³²½« p½√Ë ¨qsave s� ÎôbÐ qsava∫X³²� p½√ Îö¦� ÷d²HM�  

ÆW×O×� WLKJ�« `³B²� e WÐU²�Ë WLKJ�« W¹UN½ w� a WÐU²� sŽ lł«d²�« pMJL¹ ¨ÌczbMŽ ¨‰Ušœù«

`OðUHL�« WŠu� w� lł«d²�« ÕU²H� ∫©≥≠¥® qJA�«

 »ËdN�« ÕU²H� jG{≈ ∫`OðUH*« WŠu� w� ©vKŽ_« w�Ë —U�O�« vKŽ ÕU²H� vB
√® Esc »ËdN�« ÕU²H�  ≤

ÆWŽd�Ð —«u(«  UFÐd� Ë√ d�«Ë_« bŠ√ ¡UN½≈ v�≈ ÃU²% U�bMŽ

 XM� «–S� ÆQD��« o¹dDÐ ¨©Circle® ¢…dz«œ¢ d�√ s� ÎôbÐ ¨©Line® ¢jš¢ d�√  d²š« p½√ ÷d²HM�  

ÆEsc »ËdN�« ÕU²H� jG{« ¨WŽd�Ð d�_« «c¼ ¡UN½≈ w� ÎU³ž«—

 sŽ lł«d²�UÐ Vždð XM�Ë ¨QD)« o¹dDÐ .b
 szU� q¹bFð Ë√ b¹bł szU� rÝdÐ XL
 «–≈ ∫Undo lł«d²�«  ≥

 XKF� ULK� Æd�«Ë_« …c�U½ w� u V²�« Ë√ ¨wÝUOI�«  «Ëœ_« j¹dý s�  ¢lł«dð¢ —“ vKŽ dI½« ¨p�–

Æp�cÐ Vždð XM� «–≈ ¨¡wý q� sŽ lł«d²�« pMJ1 ¨tÐ XL
 qLŽ dš¬ sŽ œU�uðË√ lł«d²¹ p�–

 j¹dý s�  ¢…œUŽ≈¢ —“ Â«b�²Ý« pMJ1 ¨QD)« o¹dDÐ undo ¢lł«dð¢ X�b�²Ý« «–≈ ∫Redo …œUŽù«  ¥



μ∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ¢…œUŽ≈¢ Â«b�²Ý« sJ1 ô Æd�«Ë_« …c�U½ w� redo WÐU²� Ë√ ¨lł«d²�« p�– fJF� wÝUOI�«  «Ëœ_«

Æ…bŠ«Ë …d� s� d¦�√

 W�Kł w� t²LÝ— ¡wý q� sŽ lł«d²�«  pMJL¹ p�c�Ë ¨…b¹bŽ  «d�  U  lł«d²�«  d�√ Â«b�²Ý« lOD²�ð  

ÆU lł«d²�« d�_ p�«b�²Ý« bFÐ …dýU³�Ë …bŠ«Ë …d� t�«b�²Ý« pMJLO� Redo …œUŽù« d�√ U�√ ÆœU�uðË√

Mouse ©…—QH�«® dýR*UÐ ◊uD)« iFÐ rÝ—
 oKG½Ë rÝd�«  kH×½ rŁ  rÝd�«  WýUý vKŽ ÊU� ULHO� dýRL�«  p¹d×²Ð  ◊uD��«  iFÐ rÝdÐ Êü« ÂuIMÝ

 «cJ¼ LINE  ∫ d�«Ë_« …c�U½ w� V²J½ ÆœU�uðË√

Command: LINE 

 WDIM�« œbŠ¢ ?Ð  œU�uðË√ VO−²�O� © ® o�«u� ‰Ušœù« ÕU²H� vKŽ ¢jš rÝ—¢ d�_« WÐU²� bOFÐ jGC½

 «cJ¼  ¢∫v�Ë_«

Specify first point:

 ÎUF³ðË ÆtLÝd²Ý Íc�« j�K� W¹«b³�« WDI½ p�cÐ œb×²� rÝd�« WýUý w� t³ždð ÌÊUJ� Í√ vKŽ dýRL�UÐ dI½√

 «cJ¼ ¢∫›sŽ lł«dð¤ Ë√ WO½U¦�« WDIM�« œbŠ¢ ?Ð œU�uðË√ VO−²�¹ p�c�

Specify next point or [Undo]: 

 w²DI½ sOÐ ÎULOI²�� ÎUDš XLÝ— p½√ b−ð „UM¼ Î«œb−� dI½«Ë WýUA�« vKŽ dš¬ ÌÊUJ� v�≈ rÝd�« dýR� „dŠ

 ô≈ pOKŽ UL� œU�uðË√ d�√ ¡UN½SÐ VždðË jI� WOD��« WFDI�« Ác¼ s� ÎU½uJ� pLÝ— ÊU� «–≈ ÆWO½U¦�«Ë v�Ë_« dIM�«

 ÆÈdš√ …d� ‰Ušœù« ÕU²H� vKŽ jGC�«

  d�_« ¡UN½ù Èdš√ ‚dÞ
 Esc `OðUHL�« WŠu� w� »ËdN�« ÕU²H� vKŽ jGC�UÐ

 Space bar ⁄«dH�« œuLŽ dIMÐ  

 dýRLK� 5LO�« —e�« vKŽ dIM�UÐ Ë√ ÆdýRLK� 5LO�« —e�« vKŽ dIM�UÐ  

Æ©¥≠¥® qJý ¨Enter UNM� —U²�ð W�b�M� WLzU
 dNE²�

 W�b�M� WLzU
 ∫©¥≠¥® qJý

 dýRLK� sOLO�« —e�« dI½ s� dNEð

 p�H½ b−ð Èdš√ …d� ‰Ušœù« ÕU²H� vKŽ jGC�« »dł ¢jš rÝ—¢ œU�uðË√ d�_ pzUN½≈ bOFÐË …dýU³� ¨Êô«

 …dOš_« WDIM�UÐ œU�uðË√ pDÐd¹ ‰Ušœù« ÕU²H� vKŽ b¹bł s� jGC�« Ê√ UL� Æjš rÝ— d�_« w� Í√ ¨oÐU��« d�_« w�

 ÆUNð«– …dOš_« WDIM�« s� ÎU
öD½≈ X�d×ð ULM¹√ ÎU½d� ÎUDš tF� V×�¹ dýRL�« Ê√ UN²E×� b−²ÝË ¨UNM� XON²½≈ w²�«



μπ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Wþu×K�

 u²K� tM� XON²½«Ë t²�b�²Ý« Íc�« ÍœU�uðË_« d�_« s� ÃËd��« bOFÐ Èdš√ …d� ‰Ušœù« ÕU²H� vKŽ jGC�«

ÆœU�uðË√ d�«Ë√ qJ� Èdš√ …d� t�H½ d�_« v�≈ œU�uðË√ „bOF¹

 ÆdýRLK� sOLO�« —e�« vKŽ dIM�UÐ Ë√  Space bar ⁄«dH�« œuLŽ dIMÐ t�H½ d�_« v�≈ ÎUC¹√ Ÿułd�« pMJL¹

 ÆÈdš√ …d� ÎUIÐUÝ ÁU½d�– U� —«dJ²Ð UNM� XON²½« w²�« WDIM�« l� jÐd�« pMJL¹ UL�

j)« rÝ—
 »ËdN�«  ÕU²H�  jGC½  d¦�√  Ë√  sO²ODš  sO²FD
  s�  ÊuJ�  jš  rÝd�

 Line ¢jš rÝ—¢ d�_« q�K�ð l³²½ rŁ tzUN½≈ Ë√ oÐU��« d�_« s� ÃËd�K�

 ∫WO�U²�« Àö¦�« ‚dD�« ÈbŠSÐ tOKŽ qB×½ Íc�«Ë

¢j)« rÝ—¢ —e�« rÝd�«  «Ëœ√ j¹dý s� dI½√  

rÝd�«  «Ëœ√ j¹dý ∫©μ≠¥® qJý

 Draw>Line WOÝUOI�« WLzUI�« s� d²š« Ë√  

 Draw WOÝUOI�« WLzUI�« ∫©∂≠¥® qJý

Line d�_« W�b�ML�« UN²LzU
 sL{Ë

 rÝ—¢ d�_« cOHMð v�≈ pK�uð UNFOLł w²�«Ë L  dB²�� ÌqJAÐ Ë√  Line d??�«Ë_« …c�U½ w� V²�√ Ë√

«cJ¼ ∫¢j��«

Command: LINE 

LINE Specify first point:   rÝd�« WýUý vKŽ v�Ë_« WDIM�« b¹b×²� dýRL�UÐ dI½√ 

Specify next point or [Undo]:   ›lł«dð¤ rÝd�« WýUý vKŽ WO�U²�« WDIM�« b¹b×²� dýRL�UÐ dI½√ 

Specify next point or [Undo]:  ›lł«dð¤ rÝd�« WýUý vKŽ WO�U²�« WDIM�« b¹b×²� dýRL�UÐ dI½√

..…………………      a�«ÆÆÆÆ WFÐ«d�« WDIM�« b¹b×²� dýRL�UÐ dI½√ ¨‰«uML�« fH½ vKŽ

…………………..

Specify next point or [Close/Undo]: C ›lł«dðØ‚öž≈¤ WDI½ ‰Ë√ l� WDI½ dš¬ jÐd�  

  ÆZðUM�« qJA�« oKž ©Close WLKJK� Î«—UB²š«® C ·d×�« wMF¹ YOŠ



∂∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 cOHMð sŽ lł«d²�« ÊS� TÞUš u¼ WODš WFDI� pLÝ— Ê√ ¢j��« rÝ—¢ d�_ „cOHMð ‚UOÝ w�  błË «–≈Ë

 rÝ—¢ d�_« cOHMð ‚UOÝ w� X½√Ë ¨p�c� ÆUndo lł«d²�« d�√ Â«b�²Ý« VKD²¹ WOD��« WFDI�« pKð rÝ— d�√

 ÆtM� ÃËd��« ÊËbÐË »uKDL�« d�_« qL�√ rŁ U dB²�� ÌqJAÐ Ë√ Undo V²�« ¢jš

 p�– ÊS� ÁcOHMð sŽ lł«d²�« b¹dðË ÎUOK� TÞUš pLÝ— Ê√ d�_« pzUN½≈ ‰UŠ  błË «–≈ ¨Èdš√ WNł s�

 ÆÎöBHM� Undo lł«d²�« d�√ Â«b�²Ý« VKD²¹

∫Wþu×K�

 ÍœR¹ –≈ ÆqBHM� d�Q� U 5ÐË  Line d�_« ‚UOÝ sL{ wŽd� —UO�� U lł«d²�« d�√ Â«b�²Ý« w� ‚d� błu¹

 WK�KÝ rÝ— s� bFÐ wN²Mð r� p½√ U*UÞ ¨W�uÝd*« ◊uD)« WK�KÝ w� WFD
 dš¬ sŽ lł«d²�« v�≈ u wŽdH�« —UO)«

 lł«d²�« v�≈ ÍœRO� ©Command: u ® Í√ line d�√ s� ¡UN²½ô« bFÐ œU�uðË√ d�«Ë√ …c�U½ w� u WÐU²� U�√ ¨◊uD)«

 Ætð«– © line® dOš_« d�_« w� UN²LÝ— w²�« ◊uD)« q�U� sŽ

∫tzUI²½« ‚dÞË szU� ©Erase® ·cŠ
 ÆrÝd�« WýUý vKŽ s� UNCFÐ u×Lð Ë√ ·c×ð Ê√ lOD²�ð œU�uðË√ w�  UMzUJ�«Ë d�UMF�« iF³� pLÝ— bFÐ

 d�«Ë_« …c�U½ w� V²�« p�cÐ ÂUOIK� Æ÷dG�« «cN� ©Erase®¢·cŠ¢ d�√ Â«b�²Ý« pMJL¹ ¨w�uÝ— szU� s� hK�²K�Ë

 Æ©∑≠¥® qJý ¨q¹bF²�«  «Ëœ√ j¹dý s�  ¢·cŠ¢ —“ d²š« Ë√ ¨©dB²�� ÌqJAÐ e ® Ë√  Erase

Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý ∫©∑≠¥® qJý

 WOÝUOI�« WLzUI�« s� ·c×�« d�√ vKŽ ‰uB×�« sJL¹ UL�

Æ©∏≠¥® qJý ¨ Modify>Erase

 UNO�Ë Modify WOÝUOI�« WLzUI�« ∫©∏≠¥® qJý

 Erase ·cŠ d�_«

 d²š«¢  tłu�  —uNþ  bMŽË   WIÐU��«   ôU×�«  lOLł  w??�Ë

 d�¹_« dýRL�« —eÐ dI½« ¨d�«Ë_« …c�U½ w� ©Select object® ¢ÎUMzU�

  ‰Ušœù« ÕU²H� U¼bFÐ jG{« Î̈UFDI²� `³BO� szUJ�« p�– vKŽ

 szU� ¡UI²½ô WI¹dD�« Ác¼ vL�ðË ÆsL¹_« dýRL�« —“ jG{« Ë√

 ÆœdHL�« ¡UI²½ôUÐ bŠ«Ë

  UMzUJ�«  Ë√  szUJ�«  dI½  w¼ WOKLF�«Ë …dýU³L�«  ‚dD�«  s�

  ·c×�«  ÕU²H� vKŽ jGC�«  rŁ  rÝd�«  s� UN�c×Ð Vžd½ w²�«



∂± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

   Æ`OðUHL�« WŠu� s� Delete

∫w�U²�« q�K�²�« l³²¹ œU�uðË√ w� bOŠËË bŠ«Ë szU� Erase ·cŠ ÊS�  ôU×�« lOLł w�Ë

Command: Erase 

 —UO²šô lÐdL�« «c¼ Âb�²Ý« ¨pick box —UO²š« lÐd� v�≈ dýRL�« ‰u×²¹ ‰Ušœù« ÕU²H� vKŽ pDG{ ‰UŠ

  d�_« qLJ½ Æt�c×Ð Vždð Íc�« dBMF�«

Select objects: 

WO�U²�« W�UÝd�« dNE²� t�c×Ð Vždð Íc�« szUJ�« dýRLK� d�¹_« —e�UÐ dI½«
Select objects:1 found

dýRLK� sL¹_« —e�« vKŽ dIM�« Ë√ ‰Ušœù« ÕU²H� vKŽ jGC�UÐ d�_« qLJ½ ¨t�cŠ »uKDL�« szUJ�« ¡UI²½« rð Í√
Select objects: 

 U�bMŽ W�Uš ¨WOKLŽ dOž WI¹dÞ Î«bŠ«Ë Î«bŠ«Ë  UMzUJ�« ¡UI²½« w� WI¹dD�« Ác¼ d³²FðË Æ·c×�« d�√ vN²½« UM¼

 ÎU
dÞ œU�uðË√ d�u¹ p�c�Ë Æ…œb×� WIDM� w� Ë√ …bŠ«Ë WNł vKŽ bł«u²ðË  UMzUJ�« s� …dO³� WOL� ·c×Ð Vždð

 ∫wK¹ UL�  UMzUJ�« ¡UI²½ô Èdš√

 œU�uðË√  ÂuIO�  ¨  rŁ  ¨¢ÎUMzU�  d²š«¢ tłuL�«  —uNþ bMŽ All  V²�«  WýUA�«  vKŽ  UMzUJ�«  q� ·c×�

«cJ¼ ÆWHOE½ WýUA�« `³BðË ÎUFOLł UN�c×Ð

Command: Erase 

Select objects: all 

5 found 

Select objects: 

 ÂbI²�
 rÝd�« s� …bŠ«Ë WNł vKŽ  UMzU� Ë√ d�UMŽ WŽuL−� ¡UI²½ô

 ¨¢ÎUMzU� d²š«¢ tłuL�« —uNþ bMF� ÆÎUC¹√ dýRL�UÐ p�– qLŽ sJL¹

  UMzUJ�« sOL¹ vKŽ ⁄—U� ÊUJ� w� …bŠ«Ë …d� d�¹_« dýRL�« —“ dI½«

 U¼bMŽ ¨—U�O�« v�≈ sOLO�« s� dýRL�« „dŠ rŁ ¨UNzUI²½UÐ Vždð w²�«

 «c¼ qF−ð Ê√ ‰ËUŠ ÆCrossing jIM� j�Ð qOD²�� Ë√ —UÞ≈ dNE¹

 Vždð w²�«  UMzUJ�« Íu²×¹ v²Š Ë√ lDI¹ Ë√ f�ö¹ jIML�« —UÞù«

 ÕU²H� U¼bFÐ jG{«Ë a�«ÆÆÆÆÆÆUN��½ Ë√ UN�c×� UNF� q�UF²�UÐ

Æ©π≠¥® qJý ¨sL¹_« dýRL�« —“ jG{« Ë√  ‰Ušœù«
—U�OK� sOLO�« s� …c�UMÐ  UMzUJ�« ¡UI²½« ∫©π≠¥® qJý



∂≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 d²š«¢ tłuL�« —uNþ bMF� ∫Èdš√ WI¹dÞ Â«b�²Ý« sJL¹ UL�

 —U�¹ vKŽ ⁄—U� ÊUJ� w� …bŠ«Ë …d� d�¹_« dýRL�« —“ dI½« ¨¢ÎUMzU�

 —U�O�«  s� dýRL�«  „dŠ rŁ ¨UNF� q�UF²�UÐ  Vždð w²�«   UMzUJ�«

 ÆWindow qB²� j�Ð qOD²�� Ë√ —UÞ≈ dNE¹ YO×Ð ¨sOLO�« v�≈

 Vždð w²�«  UMzUJ�« Íu²×¹ qB²L�« —UÞù« «c¼ qF−ð Ê√ ‰ËUŠ

 dýRL�«  —“  jG{« Ë√   ‰U??šœù«  ÕU²H�  U¼bFÐ  jG{«Ë UNzUI²½UÐ

Æ©±∞≠¥® qJý sL¹_«sOLOK� —U�O�« s� …c�UMÐ  UMzUJ�« ¡UI²½« ∫©±∞≠¥®qJý

 ¢ÎUMzU� d²š«¢ Y×LK� WÐU−²ÝU� W WÐU²JÐ Crossing selection lDI²� Ë√ jIM� —UÞ« vKŽ ‰uB×�« sJL¹

 W WÐU²JÐ Window selection qB²� —UÞ« vKŽ ‰uB×�« sJL¹ ULMOÐ ÆÈd�O�U� ÎôË√ vMLO�« sO²¹Ë«e�« œb×½ rŁ

 WFÞUI²� U�≈ ÊuJð …—U²�L�« d�UMF�«Ë ÆvMLO�U� ÎôË√ Èd�O�« sO²¹Ë«e�« œb×½ rŁ ¢ÎUMzU� d²š«¢ Y×LK� WÐU−²ÝU�

  Æq�UJ�UÐ qB²L�« —UÞù« qš«œ Ë√ tKš«œ Ë√ jIML�« —UÞù« l�

rÝd�« kHŠ
 œU�uðË√ s� w{«d²�ù« rÝù« X×ð wz«b²Ð« nK� sL{ ÊuJð v�Ë_« …dLK� œU�uðË√ Z�U½dÐ p�ušœ ‰UŠ

 r� rÝd�« Ê_Ë ÆFile>Save Í√ ¨wÝUOI�«  «Ëœ_« j¹dý s� SAVE d²š≈ t²LÝ— U� kH×� ÆDrawing1.dwg

 Æ©±±≠¥® qJý ¨©Save Drawing As® ¢rÝUÐ kHŠ¢ —«u×�« lÐd� ÷dFÐ œU�uðË√ ÂuIOÝ bFÐ kH×¹

 X³ž— «–≈  ÆtO�  pLÝ— kH×Ð Vždð Íc�«  bK−L�«Ë ’dI�«  œbŠ „UM¼

 ACAD2002 bK−L�« vKŽ ≤∞∞≤ œU�uðË√ ”Ë—œ s� ‰Ë√ ”—b� tEH×Ð

∫WO�U²�« WGOB�UÐ tEH×½ UM½S� V²JL�« `DÝ sL{

Desktop:\ACAD2002\LESSON1.

 j¹dý s�    —e�« jG{« rÝd�« kH(

ÆwÝUOI�«  «Ëœ_«

  «dOOG²�«Ë pLÝ— kH% Ê√ ÎULz«œ d�cð

Æq
√ Ë√ ozU
œ μ q� tOKŽ Wz—UD�«



∂≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Save Drawing As —«u×�« lÐd� ∫©±±≠¥® qJý

œU�uðË√ ‚öž≈
 vKŽ jG{« Ë√ d�«Ë_« …c�U½ w� Quit Ë√ Exit s¹d�_« bŠ√ V²�√ Ë√ ¨File> Exit d²š≈ ¨œU�uðË√ W�Kł ¡UN½ù

ÆrÝd�« WýUA� vMLO�«Ë W¹uKF�« W¹Ë«e�« w� …œułuL�«  X…—Uýù«

∫tO³Mð

 rÝd�« «c¼ Ê√ błË «–S� ¨rÝd�« vKŽ  ö¹bFð W¹√ œułË ÂbŽ s� Z�U½d³�« oI×²¹ œU�uðË√ ‚öžSÐ ÂuI½ U�bMŽ

 ŸUO{ s� vA�ð ô Ê√ pOKŽ «cN�Ë ¨p�– sŽ t�Q�¹ t½S� UNEH×Ð bFÐ Âb�²�L�« rI¹ r�  ö¹bFð vKŽ Íu²×¹

ÆœU�uðË√ ‚öž≈ bMŽ p�uÝ—

 nKL�« kH×Ð ÂuI¹ w½U¦�« d�_U� Æd�«Ë_« …c�U½ w� Save d�_«Ë Qsave d�_« WÐU²� sOÐ W−O²M�« w� ‚d� błu¹

 w� Save —e�« vKŽ dIM�« Ë√ File>Save —UO²š« ULMOÐ ÆSave As Í√ q³
 s� t²EHŠ b
 XM� u� v²Š b¹bł rÝUÐ

 Æ…b¹b−�« tð«dOG²Ð nKL�« kH×� ÊU¹œRO� WOÝUOI�« WLzUI�«



∂¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

s¹—ULð
∫WO�U²�« rÝd�« d�«Ë√ l³²ð rŁ ¨·ËdF� ÌbK−� sL{ EA1 rÝôUÐ Save As d�_UÐ tEHŠ«Ë Î«b¹bł ÎUHK� `²�≈

 lDI�« iFÐ rÝ— sŽ lł«dð rŁ ¨rÝd�« WýUý vKŽ X½U� ULHO� WLOI²�*« ◊uD)« s� WŽuL−� rÝ—√  ±

 ÆÁdšü d�_« qL�√ rŁ Line ¢jš¢ d�_« w� X½√Ë WOD)«

ÆC ¢…dz«œ¢ d�_UÐ WHK²�� s�U�√ w�Ë r−(« WHK²�� dz«Ëœ rÝ—√  ≤

 ÆRec ¢qOD²��¢d�_UÐ ÊUJ*«Ë r−(« WHK²��  öOD²�� rÝ—√  ≥

 ÆE ¢·cŠ¢ d�_UÐ ◊uDš WŁöŁË 5ðdz«œË Î«bŠ«Ë ÎöOD²�� ·cŠ≈  ¥

 ÆU sŽ lł«dð d�_UÐ ¢·cŠ¢ d�_« sŽ lł«dð Í√ Æt²KLŽ d�√ dš¬ sŽ lł«dð  μ

ÆRedo …œUŽ≈ d�_UÐ WIÐU��« …œUŽù« WOKLŽ sŽ lł«dð  ∂

 ÆU d�_UÐ t²KF� ULŽ lł«dð rŁ —U�OK� 5LO�« s� Crossing Selection¢jIM� Ì—UÞ≈¢ sL{ …œb×�  UMzU� ·cŠ≈  ∑

ÆUd�_UÐ t²KF� ULŽ lł«dð rŁ 5LOK� —U�O�« s� Window Selection¢qB²� Ì—UÞ≈¢sL{ …œb×�  UMzU� ·cŠ≈  ∏

 Æ Saved�_UÐ nK*« vKŽ W&U½  «dOG²�« l� t²LÝ— U� kHŠ≈  π

Æ Ud�_UÐ p�– qF� sŽ lł«dð rŁ  Erase>Alld�_UÐ WýUA�« vKŽ t²LÝ— U� lOLł ·cŠ≈  ±∞

ÆÎU³¹dIð WýUA�« nB²M� w� U¼e�d� …dz«œ rÝ—√  ±±

ÆwÝUOI�«  «Ëœ_« j¹dý s�Save  —e�« dIMÐ Wz—UD�«  «dOG²�« kHŠ≈ ¨Èdš√ …d�  ±≤

 Æ Exitd�_UÐ œU�uðË√ oKž√  ±≥

dýRL�UÐ rÝd�« 



∂μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫WFł«dLK� WK¾Ý√

∫WO�U²�« d�«Ë_« b&  «Ëœú� Ìj¹dý Í√ w�  ±

 ÆPolygon lKC�ËCircle  …dz«œ ¨Line jš       ≠√    

ÆFillet W�UŠ d¹ËbðË Extend œ«b²�≈ ¨Trim V¹cAð   ≠»    

øW¹œU�uð√ d�«Ë_  «—UB²šU� WO�U²�« ·Ëd(« d�«Ë_« …c�U½ w� UM³²� «–≈ qB×½ «–U� vKŽ  ≤

1- Command: A

2- Command: L

3- Command: C

4- Command: E

 œU�uðË√ d�«Ë√ s� iFÐ vKŽ ·dFðË d�«Ë_« …c�U½ w� …œdHM� W¹eOK$ù« W¹b−Ð_« ·Ëd(« WÐU²� »dł  ≥

Æ…—uNA*«

 ÆrÝd�«  «Ëœ√ j¹dA� WO�U²�«  U½uI¹_« WHOþË V²�√  ¥

rÝd�«  «Ëœ√ j¹dý



∂∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

oO�b�« rÝd�« ∫w½U¦�« ”—b�«
 WOÝUÝ_« d�UMF�« rÝd� œU�uðË√ w� WHK²�L�«  UOŁ«bŠù« WLE½√ Â«b�²Ý« WOHO� w½U¦�« ”—b�« w� rKF²MÝ

 ÆÎUIO
œ ÎULÝ—  UFKCL�«Ë dz«Ëb�«Ë  öOD²�L�«Ë ◊uD��U�

b¹bł rÝ— ¡bÐ
Æw�U(« nK*« ‚öžù File> Close d²š≈   ±

  Create  ÊU�K�« s�Ë Æ©±≤≠¥® qJý ¨AutoCAD 2002 Today …c�UM�« p� dNE²Ý ¨File>New d²š«   ≤

 w� ©Metric®¢Íd²�¢ d²š« rŁ ©Start from Scratch® Í√ ¢¡wý ô s� ¡b³�«¢ —UO)« œbŠ Drawings

 ÆpLÝ— w� W¹d²*«  «bŠu�« ‰ULF²ÝUÐ Vždð p½_ qHÝ_«

          

—U�O�« vKŽ ¡wý ô s� ¡b³�«Ë sOLO�« vKŽ b¹bł nK� `²� ∫©±≤≠¥® qJý

∫Wþu×K�

 Ë√  WFzUA�«  w¼Ë  W¹d²LOKO�   «bŠuÐ  rÝdð  bI�  ÆUN³ždð   «b??ŠË  W¹QÐ  œU�uðË√  w�  rÝd�«  r²¹  WIOI×�«  w�

 rÝdð X�œ U� ‚dH�UÐ dFAð s�Ë tÐUA²� ÌqJAÐ rÝd�«  «bŠË lOLł l� q�UF²²Ý sO²�U×�« w�Ë Æg½ù«  «bŠË

 W¹d²LOKOL�«  «bŠu�« U�≈ bŠ«u�« nKL�« w� Âb�²�ð Ê√ qCH¹ sJ� ÆbŠ«u�« rÝd�« nK� w�  «bŠu�« ÈbŠSÐ

 Æg½ù«  «bŠË U�≈Ë

   



∂∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

rÝd�« œËbŠ j³{
 r−Š v�≈ rÝd�« œËbŠ j³{ s�×²�L�« sL� p�c�Ë ¨wIOI×�« UNÝUOILÐ …œUŽ œU�uðË√ w� ¡UOý_« rÝdð

 r−Š v�≈  rÝd�«  œËbŠ j³{ UM�eK¹  t½S�  ÷dF�UÐ  A4  W
—Ë vKŽ rÝd�UÐ  UM³ž—  «–≈  ÆtLÝdÐ  ÂuI½  Íc�«  TOA�«

 rÝd�« œËbŠ ÎôË√ ·dF½ ¨p�c� Æ©±≥≠¥® qJý ¨ŸUHð—û� d²LOK� ≤±∞ Ë ‰uDK� d²LOK� ≤π∑ Í√ W
—u�« Ác¼

 rÝd�« œËbŠ j³C� Limits WLKJ�« d�«Ë_« …c�U½ w� V²�√ ∫WÐuKDL�«

∫tO³Mð
 Ê√ lOD²�ð ô p½√ rÝd�« œËbŠ wMFð ô

 ÆrÝd�« bMŽ U¼“ËU−²ð

    

  ÷dF�UÐ A4 rÝd�« W
—Ë œËbŠ∫©±≥≠¥® qJý

Command: Limits 

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: 

Æœd�« wðQ¹ UM¼Ë (0,0) UNðUOŁ«bŠ≈ w²�«Ë WOKH��«Ë Èd�O�« W¹Ë«e�« s� oKDM½ UM½_ sOI�«u� ‰Ušœù« ÕU²H� jGC½ ¨UM¼

Specify upper right corner <420.0000,297.0000>: 297,210

 v�≈  <420.0000,297.0000>  dG�√Ë d³�√ wð—Uý≈ sOÐ  WMO³L�«  œU�uðË√ Z�U½d³�  WO{«d²�ù« WLOI�«  dOG½  UM½√  Í√

 Æ297,210  Y×L�« rIK½ ¨p�c� Æb¹b×²�UÐ A4 rÝd�« W
—Ë œUFÐ√ l� o�«u²ð w²�«Ë …b¹b−�« WLOI�«

 s� d²š≈ ¨p�c� ÆœU�uðË√ w� rÝd�« W
œ b¹b×²� W¹dAF�« q�«uH�« j³{ v�≈ ÃU²×½ b
 ¨Èdš√ WNł s�

 —«uŠ lÐd� ÷dFÐ sO²�U×�« w� œU�uðË√ ÂuIO� ¨Units d�«Ë_« …c�U½ w� V²�« Ë√ Format>Units WOÝUOI�« WLzUI�«

  «bŠË r�
 w� Decimal ¢ÍdAŽ¢ ¡UI²½« s� „UM¼ b�Qð Æ©±¥–¥® qJý ¨Drawing Units ¢rÝd�«  «bŠË¢

 jG{«Ë Precision ¢W
b�«¢ v�≈ qI²½« rŁ ÆAngle ¢W¹Ë«“¢ r�
 w� ¢W¹dAŽ  Uł—œ¢Ë ¨Length ¢‰uD�«¢

ÆOk o�«u� —“ jG{« rŁ ¢0¢ d²š«Ë ¢0.0000¢ —«uł v�≈ rN��« vKŽ



∂∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

“rÝd�«  «bŠË” —«u×�« lÐd� ∫©±¥≠¥® qJý

 «–S�  ¨rÝd�«  W
œË o�«u²¹  rÝd�«  WýUý vKŽ dNE¹  U�  sJ�Ë œËb×�«  bFÐ√  v�≈  oO
œ  œU�uðË√  w�  tLÝdð  U�

  «bŠË ±∞ ”UOI�«  bMŽ t�uÞ Ê√ b−²Ý `O×� ± W
bÐ …bŠË π[∏¥π≤ wKFH�«  t�uÞ ÎULOI²�� ÎUDš XLÝ—

 Æ∞[∞± W
bÐ …bŠË π[∏μ Ë ∞[± W
bÐ …bŠË π[∏ ©j��«® tÝUO
 ÊuJ¹Ë ¨‰ULJ�«Ë ÂUL²�UÐ

 YO×Ð WO�U×�« WM¹UFL�« œËbŠ j³C� ÆrÝd�« WýUý vKŽ ÎUO�Uð tLÝd²Ý U�  «bŠËË W
œ j³CÐ œU�uðË√ w� u²K� XL


«cJ¼ ¨A  rŁ Z ∫V²�« ¨rÝd�« WýUý vKŽ szU� Í√ rÝd½ Ê√ q³
 A4 W
—Ë w¼ w²�«Ë rÝd�« œËbŠ wDGð

Command: Z 

ZOOM

Specify corner of window, enter a scale factor (nX or nXP), or

[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: A  

 UOŁ«bŠù« WLE½√ rN	
 «c¼ “ËU−²ðô p�c�Ë ÆWHK²�L�«  UOŁ«bŠù« rE½ rN� vKŽ ¨œU�uðË√ w� U¼d¹d×ðË  UMzUJ�« rÝ— n
u²¹

ÆÎU×O×� ÎULN� tLN� s� b�Q²�« q³
 r�I�«



∂π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

©Absolute Cartesian Coordinate System® oKD*« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½
 r
d�« q¦L¹ Æ©X,Y®WK�U� ULNMOÐ qBH¹ ÂU
—_« s� ÃËeÐ oKDL�« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½ w� WDIM�« ·dFð

 ¢’¢ w½U¦�« r
d�« q¦L¹Ë ÆWMOFL�« WDIM�«Ë  ÍœUB�«  UOŁ«bŠù« —u×� sOÐ WK�UH�« W�U�L�« X  Ë√ ¢”¢ ‰Ë_«

 wð—UJ¹b�« WH� ÂUEM�« «c¼ vKŽ oKD¹ p�c�Ë ÆUNð«– WDIM�«Ë wMO��«  UOŁ«bŠù« —u×� sOÐ WK�UH�« W�U�L�« Y Ë√

 ÆWOŠU�L�« ‰ULŽú� VÝUM� tMJ�Ë ¨w�uO�« qLF�« w� œU�uðË√ w� ÂUEM�« «c¼ Â«b�²Ý« qCH¹ ôË ÆoKDL�«

©±μ≠¥® qJý   ∫± ‰U¦�

 qO�²MÝ ÆB(30,40) ULMOÐ A(20,10) ULNðUOŁ«bŠ≈ Ê√ YOŠ ¨B Ë A sO²DIM�« sOÐ ©WOD��« WFDI�«® rOI²�L�« j��« rÝ—√

 Èd�O�« W¹Ë«e�« w� √b³ð WIKD�  UOŁ«bŠ≈ W
—u�« w� Ê√ qO�²½ ÆW�ËdF� œUFÐ√ UN� WDD��Ë WKOD²�� W
—Ë vKŽ rÝd½ UM½√

  Line d�_« V²�√ ÆLimits d�ú� ÎUI�Ë (297,210) WDIM�« w� vMLO�«Ë W¹uKF�« WDIM�« w� wN²MðË (0,0) WDIM�« w� WOKH��«Ë

Command: LINE 

Specify first point: 20,10 

Specify next point or [Undo]: 30,40

Specify next point or [Undo]: 

©Relative Cartesian Coordinate System® w³�M�« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½
 dš¬ sOÐ wMO��« bF³�« ©dx®q¦Lð  Æ©@dx,dy®…—U³FÐ w³�M�« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½ w� WDIM�« ·dFð

 dš¬ sOÐ ÍœUB�« bF³�« (dy) q¦Lð UL� Æ©Delta x sO²DIM�« sOÐ wMO��« bF³�« Ë√® WO�U²�« WDIM�«Ë UN�Ušœ≈ rð WDI½

 WH� ÂUEM�« «c¼ vKŽ oKD¹ p�c�Ë Æ©Delta y sO²DIM�« sOÐ ÍœUB�« bF³�« Ë√® WO�U²�« WDIM�«Ë UN�Ušœ≈ rð WDI½

Æw³�M�« wð—UJ¹b�«

©±μ≠¥® qJý   ∫≤ ‰U¦�

 WDIM�« bF³ð ULMOÐ A(20,10)  UOŁ«bŠ≈ Ê√ YOŠ ¨C Ë A sO²DIM�« sOÐ ©WOD��« WFDI�«® rOI²�L�« j��« rÝ—√ 

Line d�_« V²�√ Æ¥∞ WOÝ√d�« W�U�L�«Ë ≥∞ WOI�_« W�U�L�UÐ A WDIM�« sŽ C

Command: LINE

Specify first point: 20,10 

Specify next point or [Undo]: @30,40

Specify next point or [Undo]: 



∑∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Æv�Ë_« WDIM�« v�≈ W³�M�UÐ WO�U²�« WDIM�« bFÐ œb×¹ Íc�« @e�d�« UM�b�²Ý« UM½√ Í√

 UOŁ«bŠù« WLE½√∫©±μ≠¥® qJý

©Relative Polar Coordinate System® w³�M�« w³DI�«  UOŁ«bŠù« ÂUE½
 W�U�L�« distance q¦L¹  Æ©@distance<angle® …—U³FÐ w³�M�« w³DI�«  UOŁ«bŠù« ÂUE½ w� WDIM�« ·dFð

 UN�Ušœ≈ rð WDI½ dš¬ sOÐ WK�U×�« W¹Ë«e�«  angle  q¦L¹Ë Æ…b¹b−�« WDIM�«Ë UN�Ušœ≈ rð WDI½ dš¬ sOÐ WK�UH�«

 Æw³�½ WH� ÂUEM�« «c¼ vKŽ oKD¹ p�c�Ë Æ” —u×� v�≈ W³�M�UÐ …b¹b−�« WDIM�«Ë

©±μ≠¥® qJý   ∫≥ ‰U¦�

 WDIM�« bF³ð ULMOÐ A(20,10)  UOŁ«bŠ≈ Ê√ YOŠ ¨D Ë A sO²DIM�« sOÐ ©WOD��« WFDI�«® rOI²�L�« j��« rÝ—√

Line d�_« V²�√ ÆWł—œ ≥∞ WO³DI�« W¹Ë«e�UÐË μ∞ WO³DI�« W�U�L�UÐ A WDIM�« sŽ D

Command: LINE 

Specify first point: 20,10 

Specify next point or [Undo]: @50<30

Specify next point or [Undo]: 

 W�bÐ qOD²�� rÝ—
  UOŁ«bŠUÐË …œb×� ÁœUFÐ√ ÎöOD²�� rÝd½ nO� ÂuO�« rKF²MÝ ÆdýRL�UÐ qOD²�� rÝ— WOHO� ÎUIÐUÝ UMLKFð

 wF
u� œb×½ tLÝd�Ë ÆÎULz«œ  WOÝ√—Ë WOI�√  tŽö{√ ÊuJð YO×Ð œU�uðË√  w� qOD²�L�«  rÝd¹  ÆÎUHKÝ W�ËdF�

 Æ  qOD²�L�« rÝd� œU�uðË√ w� Âb�²�L�« e�d�« p�– v�≈ dOA¹ UL� ÎU�ULð sO²KÐUI²L�« tO²¹Ë«“



∑± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ∫¥ ‰U¦�

Æ…bŠË μ∞ tŽUHð—«Ë ±∞∞ t�uÞ Íc�« qOD²�L�« rÝ—√

Command: Rectangle  (Rec )

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: انقر أية نقطة على الشاشة

Specify other corner point or [Dimensions]: @100,50 

 ∫μ ‰U¦�

 Æ@100,50 ÎôbÐ 100,50 Y×L�« w� UMLI� «–≈ …bŠË μ∞ Ë ±∞∞ oÐU��« qOD²�L�« ‰«uÞ√ ÊuJð q¼

∫∂ ‰U¦�

 Æt�«uÞ√ W�ËdFL�« qOD²�L�« rÝd� Èdš√ WI¹dÞ

Command: Rec 

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]:       WýUA�« vKŽ WDI½ W¹√ dI½«

Specify other corner point or [Dimensions]:  D

 Ætð«– qOD²�L�« Dimensions  ¢œUFÐ√¢ v�≈ qOD²�LK� WO½U¦�«  WDIM�«  l
u� b¹b×ð s� Y×L�« U½dOž ¨UM¼

 «cJ¼ Æ…bŠË μ∞ Width ŸUHð—ô«Ë …bŠË ±∞∞ Length ‰uD�« rOIK²Ð d�_« qLJ½ ÆD ·d×�« UM³²� p�c�Ë

Specify length for rectangles <500.0000>: 100 

Specify width for rectangles <40.0000>: 50 

Specify other corner point or [Dimensions]:

Æ»uKDL�« qOD²�L�«« Z²MO� WOKH��« Â√ W¹uKF�« sO²N−�« ÈbŠ≈ dýRL�UÐ dIM½

∫∑ ‰U¦�

 ÆqOD²�L�« rÝd� ÁöŽ√ sOðœ—«u�« sO²I¹dD�UÐ …bŠË ≤∞ tFK{ t�uÞ Íc�« lÐdL�« rÝ—√



∑≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 UFKC*« rÝ—
 rÝdÐ œU�uðË√ ÂuI¹ ¨ÎUO{«d²�« ÆUN�U−Š√Ë UNŽö{√ œbŽ ·ö²š« vKŽ  UFKCL�« rÝ— s� œU�uðË√ UMMJL¹

 fLð Ë√ ©Inscribed in circle …dz«b�« qš«œ lKCL�«® lKCL�« ”Ëƒ— w� dLð WOL¼Ë …dz«œ v�≈ Î«œUM²Ý« lKCL�«

 rÝd� Èdš√ WI¹dÞ d�u²ð UL� Æ© Circumscribed about circle …dz«b�« Ã—Uš lKCL�«® qš«b�« s� tŽö{√

 Î«œUM²Ý« ÁöŽ√ œ—«u�« lÐdL�« rÝd� Èdš√ WI¹dÞ rKF²½ Ê√ dýU³� ‰U¦L�Ë ‰ËU×MÝ ÆtFK{ ‰uÞ v�≈ Î«œUM²Ý« lKCL�«

 ÆrE²M� wŽUÐ— lKC� t½√ v�≈

∫∏ ‰U¦�

 Æ…bŠË ≤∞ tFK{ ‰uÞ Íc�« lÐdL�« rÝ—«

 Pol  Ë√  Polygon  V²�√ Ë√ rÝd�«  «Ëœ√ j¹dý w� ¨©±∂≠¥® qJý  ̈Polygon ¢lKC�¢ —e�« d²š«

Æ‰Ušœù« ÕU²H� jG{«Ë d�«Ë_« Y×� w�dB²�� qJAÐ

 UFKCL�«∫©±∑≠¥® qJý
         

  lKCL�« rÝ— —“ tO�Ë rÝd�«  «Ëœ√ j¹dý ∫©±∂≠¥® qJý

Command: Polygon 

Enter number of sides ¢Ÿö{_« œbŽ qšœ√¢ ?Ð VO−²�¹ d�«Ë_« Y×� Ê√ b−ð sO²�U×�« w�Ë

Enter number of sides <3>: 4         ‰Ušœù« ÕU²H� jG{«Ë ¥ V²�« 

Specify center of polygon or [Edge]: e 

 ‰Ušœù« ÕU²H� jG{« rŁ Edge ¢lKC�« ‰uÞ¢ —UO²šô« cOHM²Ð Vždð p½√ wMFð  e·d×�« WÐU²�

Specify first endpoint of edge: 100,100           U¼œbŠ Ë√ U� WDI½ dI½√ 

Specify second endpoint of edge: @20,0 

Æ©±∑≠¥® qJý ¨100,100 v�Ë_« WDIMK� W³�½ lKC�« W�UŠ  UOŁ«bŠ≈ œb×½  @20,0 ?Ð UM¼



∑≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫π ‰U¦�

©±∑≠¥® ¨…bŠË ≥∞ tFK{ t�uÞ Íc�« fL�L�« rÝ—√

Command: Polygon 

Enter number of sides <4>: 5 

Specify center of polygon or [Edge]: e 

Specify first endpoint of edge: 100,100          U¼œbŠ Ë√ U� WDI½ dI½√

Specify second endpoint of edge: @30,0 

∫±∞ ‰U¦�

  Æ…bŠË ±∞∞ U¼dD
 nB½ ¨WOL¼Ë …dz«œ tÝËƒ— w� dLð Íc�« YK¦L�« rÝ—√

Command: Polygon 

Enter number of sides <4>: 3 

Specify center of polygon or [Edge]:      WýUA�« vKŽ WDI½ W¹√ dI½«

Enter an option [Inscribed in circle/Circumscribed about circle] <I>: I

Specify radius of circle: @100<0 

∫±± ‰U¦�

Æ…bŠË ±∞∞ U¼dD
 nB½ ¨WOL¼Ë …dz«œ tŽö{√ fLð Íc�« YK¦L�« rÝ—√

Command: Polygon 

Enter number of sides <5>: 3 

Specify center of polygon or [Edge]:         WýUA�« vKŽ WDI½ W¹√ dI½«      

Enter an option [Inscribed in circle/Circumscribed about circle] <I>: C 

Specify radius of circle: @100<0 

 œU�uðË√ w	 dz«Ëb�« rÝ—
 uŽb½ ULMOÐ ©radius® dDI�« nBMÐ bF³�« p�– vL�¹Ë ÆU� WDI½ sŽ ÎU²ÐUŁ Î«bFÐ tÞUI½ bF³ð wÝbM¼ szU� …dz«b�«

∫w�U²�« ‰U¦L�UÐ UNKN²�½ ¨…dz«b�« rÝd� ‚dÞ …bŽ œU�uðË√ d�u¹Ë Æe�dL�UÐ W²ÐU¦�« WDIM�«



∑¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫±≤ ‰U¦�

 Ác¼ rÝd� øW¹—UO²š« WLO
 W¹√ U¼dD
 nB½Ë rÝd�« WýUý vKŽ U� WDI½ U¼e�d� w²�« …dz«b�« dýRL�UÐ rÝ—√

 ∫WO�U²�«  «uD��« l³²MÝ  UH�«uL�« ÁcNÐ …dz«b�«

 rÝd�«  «Ëœ√ j¹dý w�   …dz«b�« —“ dI½« Ë√ d�«Ë_« Y×� w� ©Î«—UB²š« C V²�« Ë√®  Circle  V²�√

 Center,Radius —UO²šô« œb×½ „UM¼Ë ¨©±∏≠¥® qJý ¨Draw>Circle WOÝUOI�« WLzUI�« s� d²š« Ë√

 UOŁ«bŠù« WLE½√ ∫©±∏≠¥® qJý

Command: Circle  (C )

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

 …bŽ œU�uðË√ pODF¹ ¨UM¼ ¤ Ë√ UNLÝd²Ý w²�« …dz«bK� Î«e�d� ÊuJ²Ý w²�« WDIM�« œb×ð Ê√ œU�uðË√ pM� VKD¹

ÆrÝd�« WýUý vKŽ WDI½ W¹√ dI½«    ÆÆÆÆ d�_« qLJ½ Æ›…dz«b�« Ác¼ rÝd�  «—UOš

 d³Jð  e�dL�« «c¼ ‰uŠ …dz«œ dNEð UL� ÆrÝd�« WýUý vKŽ ÎULÝ— …dz«b�« e�d� p� œb×O� œU�uðË√ VO−²�¹ UM¼

 …dz«b�« Radius dD
 nB½ œb×ð Ê√ œU�uðË√ pM� VKD¹ ¨UM¼ ÆrÝd�« WýUý vKŽ dýRL�« W�d×� ÎUI�Ë dGBðË

 d�_« qLJ½ Æ›…dz«bK� Diameter dDI�« u¼ dš¬ Î«—UOš œU�uðË√ pODF¹¤ Ë√ UNLÝd²Ý w²�«

Specify radius of circle or [Diameter]:      dš¬ ÌÊUJ� Í√ w� dI½«Ë WýUA�« vKŽ dýRL�« V×Ý« 

 ÂuIð XM� «–≈Ë ÆU¼e�d�  UOŁ«bŠ≈ ôË U¼dD
 nB½ ô ·ËdF� dOž ¨…dz«œ XLÝ— p½√ V�UD�« Íe¹eŽ kŠöð

 U� sJ�Ë ¨…dz«b�« dD
 nB½ ’uB�Ð  UŠd²I� W¹√ œU�uðË√ pOKŽ Õd²I¹ sK� ¨rÝd�« W�Kł w� …dz«œ ‰Ë√ rÝdÐ



∑μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 pMJL¹Ë Æcircle d�√ X�b�²Ý« ULK� W�uÝd� …dz«œ dš¬ dD
 nB½ Õ«d²
UÐ œU�uðË√ ÂuI¹ v²Š …dz«œ ‰Ë√ rÝdð Ê≈

 Æ„bŠu� p�– »dł ÆW�uÝd� …dz«œ dš¬ dD
 nB½ UN� ÊuJ¹ YOŠ …b¹b−�« …dz«b�« rÝ— ‰Ušœù« ÕU²H� jGCÐ

ÁöŽ√ œ—«u�« ¨©±∏≠¥® qJý dE½√ ¨…dz«b�« rÝd� WMJL*«  «—UO²šô«
 Æ©radius® U¼dD
 nBM� ©center® …dz«b�« e�d� b¹b×ð

 Æ©diameter® U¼dDI� …dz«b�« e�d� b¹b×ð

 Æ…dz«bK� Î«dD
 ÊöJA¹ ¨…dz«b�« jO×� vKŽ sO²DI½ b¹b×ð

 ÆÂuÝd� YK¦� ”Ëƒ— w� dLð …dz«œ rÝ—√ ¨Îö¦� Æ…dz«b�« jO×� vKŽ ◊UI½ ÀöŁ b¹b×ð

ÆU¼dD
 nB½ b¹b×ðË ¨…dz«bK� sOÝUL� ¡UI²½«

 ÆÂuÝd� YK¦L� WŁö¦�« Ÿö{_« fLð …dz«œ rÝ—√ ¨Îö¦� Æ…dz«bK�  UÝUL� WŁöŁ ¡UI²½«

 ÆU¼dD� nB½Ë U¼e�d� b¹b×²Ð      ∫ÎôË√  
 …c�U½ w� WDI½ dIMÐ ÁöŽ√ œ—Ë UL� U¼e�d�  UOŁ«bŠ≈ ôË U¼dD
 nB½ ô ·ËdF� dOž …dz«œ W¹√ rÝ— sJL¹

 ŸU³ðUÐ U�≈Ë …dz«b�« pK²� dDI�« nB½ sOð—uIML�« sO²DIM�« sOÐ bF³�« œb×O� Èdš√ WDI½ dI½ rŁ U¼e�d� b¹b×²� rÝd�«

 WIO
b�« WI¹dD�« ÂuIðË Æd�«Ë_« …c�U½ w� WÐU²� …dz«b�« dD
 nB½Ë e�dL�«  UOŁ«bŠ≈ rO
 rOIK²� WIO
b�« WI¹dD�«

 Ë√ ¨…dýU³� t²ÐU²� sJLO� dDI�« nB½ U�√ Æ©x,y® WIKDL�« WOð—UJ¹b�« WGOB�UÐ …dz«b�« e�d�  UOŁ«bŠ≈ WÐU²� vKŽ

 Æ UOŁ«bŠù« WLE½√ bŠ_ ÎUI�Ë Áb¹b×ð

∫±≥ ‰U¦�

 Æ(0,0) WDIM�« w� U¼e�d�Ë …bŠË μ∞ U¼dD
 nB½ w²�« …dz«b�« rÝ—√

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 0,0 

Specify radius of circle or [Diameter]: 50 



∑∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫U¼dDI	 …dz«b�« e�d� b¹b×²Ð     ∫ÎUO½UŁ  
 ÆU¼dD
 nBM� U¼e�d� b¹b×²Ð …dz«b�« rÝ— »uKÝ√ »uKÝ_« «c¼ t³A¹

∫±¥ ‰U¦�

Æ(0,0) WDIM�« w� U¼e�d�Ë …bŠË ±∞∞ U¼dD
 w²�« …dz«b�« rÝ—√

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 0,0 

Specify radius of circle or [Diameter]: d

Specify diameter of circle: 100

∫s¹d9
 øw�U²�« …dz«b�« rÝ— d�√ rOIKð s� W−ðUM�« …dz«b�« dD
 U�

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 0,0

Specify radius of circle or [Diameter]: 100

  ∫»«u−�«

∫ÎU¹dD� 5²KÐUI²� ¨…dz«b�« jO×� vKŽ 5²DI½ b¹b×²Ð      ∫ÎU¦�UŁ  
 Æ…dz«bK� Î«dD
 ULNMOÐ W�U�L�« qJAðË UNDO×� vKŽ sO²�ËdF� sO²DI½ s� ÎU
öD½≈ …dz«œ rÝd� WI¹dD�« Ác¼ Âb�²�ð

∫±μ ‰U¦�

 ÆU¼dD
 ÊöJA¹ sO²DI½ s� dýRL�UÐ …dz«œ rÝ—√

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2p

 d�_« qLJ½ Æ2points s� 2p sO²DI½ v�≈ …dz«b�« e�d� —UO²š« U½dOž UM¼

Specify first end point of circle's diameter:      v�Ë_« WDIM�« œbŠ

Specify second end point of circle's diameter:      WO½U¦�« WDIM�« œbŠ



∑∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫±∂ ‰U¦�

 ∫w�U²�« q�K�²�UÐ r²¹ »«u−�« Æ(120,60) Ë (60,80) sO²O�U²�« sO²DIM�« w� …—UL�« …dz«b�« rÝ—«

Command: C 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2p 

Specify first point on circle: 60,80

Specify second point on circle: 120,60 

∫…dz«b�« jO×� vKŽ ◊UI½ ÀöŁ b¹b×²Ð     ∫ÎUFÐ«—  
 vKŽ Àö¦�« ◊UIM�« ÊuJð ô Ê√ w¼b³�« s�Ë ¨…dz«b�« jO×� vKŽ ◊UI½ WŁöŁ b¹b×²Ð ÎUC¹√ …dz«b�« rÝ— sJL¹

∫dýRL�UÐ …dz«b�« Ác¼ rÝ— WI¹dÞ w�U²�« q�K�²�« q¦L¹ Æ…bŠ«Ë W�UI²Ý«

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 3p

Specify first point on circle:       v�Ë_« WDIM�« œbŠ

Specify second point on circle:        WO½U¦�« WDIM�« œbŠ

Specify third point on circle:          W¦�U¦�« WDIM�« œbŠ

 …œb×� WŁö¦�« ◊UIMK� WIKDL�«  UOŁ«bŠù« X½U� «–S� ÆYK¦� ”ËƒdÐ …—UL�« …dz«b�« rÝd� WFzUý WI¹dD�« Ác¼

 ∫¢…dz«b�« rÝ—¢ d�_ rOI�« pKð rIK½ UM½S� ÂU
—_UÐ

∫±∑ ‰U¦�

 ∫w�U²�« q�K�²�UÐ r²¹ »«u−�« Æ(55,60) Ë (40,100) ¨(0,0) WO�U²�« WŁö¦�« ◊UIM�« w� …—UL�« …dz«b�« rÝ—«

Command: C 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 3p 

Specify first point on circle: 0,0 

Specify second point on circle: 40,100 

Specify third point on circle: 55,60



∑∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 dDI�« nB½Ë 5ÝUL*« WI¹dDÐ    ∫ÎU��Uš  
 s¹œułu� sOÝu
 Ë√ sODš œU�uðË_ œb×½ Æ…dz«b�« rÝd� …dýU³L�« dOž WLNL�« ‚dD�« s� WI¹dD�« Ác¼ d³²Fð

 ÆUNLÝd¹Ë …dz«b�« e�d� b¹b×²Ð œU�uðË√ ÂuIO� dDI�« nB½ WLO
 rIK½ rŁ sOÝULL� rÝd�« w�

∫±∏ ‰U¦�

 Æœb×� U¼dD
 nB½Ë sO�uÝd� sODš fLð w²�« …dz«b�« rÝ—√

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: ttr

 dD
 nB½ ”UL� ”UL� Í√ Tangent Tangent Radius W¹eOK−½ù«  ULKJ�« s� ttr  «—UB²šù«  ¡Uł

 Æt�H½ d�_« ‚UOÝ sL{  ULKJ�« pK²� v�Ë_« ·dŠ_« s� …dB²��  ¡Uł Ác¼Ë

Specify point on object for first tangent of circle:  ‰Ë_« j��« ‚u� ‰Ë_« ”ULL�« dI½«

Specify point on object for second tangent of circle:  w½U¦�« j��« ‚u� w½U¦�« ”ULL�« dI½«

Specify radius of circle:   …—QH�« Â«b�²ÝUÐ p�– œbŠ Ë√ …dz«b�« dD
 nB½ qšœ√

  ∫w�U²�« ‰U¦L�« ÷dF²�½ ·ËdF� U¼dD
 nB½Ë sOðœb×� sOðdz«œ Ë√ sO¹dz«œ sOÝu
 fLð …dz«œ rÝd�Ë

∫±π ‰U¦�

  Æ©±π≠¥® qJý ¨…bŠË ≥∞ U¼dD
 nB½Ë sOðdz«œ fLð w²�« …dz«b�« rÝ—«

Command: C

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: ttr

Specify point on object for first tangent of circle:    v�Ë_« …dz«b�« dI½« 

Specify point on object for second tangent of circle:    WO½U¦�« …dz«b�« dI½«

Specify radius of circle: 30 

ÎUC¹√ —U�O�« vKŽ  P2 Ë P1 ◊UIM�« Ê_ —U�O�« vKŽ WO−�HM³�« …dz«b�« XLÝ— ∫©±π≠¥® qJý



∑π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 —UO²šUÐ œU�uðË√ ÂuI¹ W�U×�« Ác¼ w�Ë ¨dDI�« nB½Ë ”UL²�« ◊dý oÐUDð …dz«œ s� d¦�√ œU�uðË√ b−¹ ÎU½UOŠ√

 Ê_ —U�O�« vKŽ …dz«b�« XLÝ— oÐU��« ‰U¦L�« w� ÆsOÝULL�« vKŽ UNðœbŠ w²�« ¡UI²½ô« ◊UI½ v�≈ »d
√ u¼ U�

Æ„bŠu� p�– »dł Æ¡«dC��«Ë ¡«dL×�« sO²OK�_« sOðdz«b�« —U�¹ vKŽ P2 Ë P1 sOð—uIML�« sO²DIM�«

  Æ©≤∞≠¥® qJý ¨…dz«bK�  UÝU2 WŁöŁ ¡UI²½«     ÎUÝœUÝ  
 Æ…dz«b�« tŽö{√ fLð YO×Ð tKš«œ …dz«b�« rÝ— »uKDL�«Ë rÝd�« WýUý vKŽ ÎU�uÝd� ÎU¦K¦� qO�²½ ¨UM¼

 WOÝUOI�« WLzUI�« s� œb×½ ¨p�c�

Draw>Circle          —UO��«

Tan,Tan,Tan,

 s� …dýU³� r²¹ dz«Ëœ WŁöŁ fLð Ë√  ULOI²�� WŁöŁ fLð w²�« …dz«b�« Ác¼ rÝ— d�√ cOHMð Ê√ W�dFL�« V−¹

 ”√— ‰u×²O�  ULOI²�L�« Ác¼ b¹b×ð VKDÐ œU�uðË√ VO−²�¹ t�«b�²Ý« ‰UŠ ¨p�c�Ë ÆjI� WOÝUOI�« WLzUI�«

 Æ…dz«b� ”UL� v�≈ dýRL�«

dz«Ëœ WŁöŁ Ë√  ULOI²�� WŁöŁ fLð …dz«œ rÝd� WOÝUOI�« WLzUI�« ∫©≤∞≠¥® qJý



∏∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫≤∞ ‰U¦�

  ÆÂuÝd� YK¦L� WŁö¦�« Ÿö{_« fLð w²�« …dz«b�« rÝ—«

Command:

 ”UL� v�≈ dýRL�« ”√— ‰u×²O� ,Tan,Tan,Tan —UO��U� Circle …dz«b�« rŁ Draw WOÝUOI�« WLzUI�« —U²�½

:_circle Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: ttt 

Specify first point on circle: _tan to     YK¦L�« w� lK{ ‰Ë√ dIM½

Specify second point on circle: _tan to    YK¦L�« w� lK{ w½UŁ dIM½

Specify third point on circle: _tan to     YK¦L�« w� lK{ Y�UŁ dIM½

rÝd�« kHŠ
 b¹b−�«  rÝô« d²š«  ÆFile>Save As  b¹bł nKL� tEHŠ«  Ë√  …b¹b−�«  tðö¹bFð  l� r¹bI�«  pHK� kHŠ«

  ÆœU�uðË√ oKž√ ÆDesktop:\ACAD2002\LESSON2

 s¹—ULð
 tEHŠ«Ë Æ`O×� bŠ«Ë v�≈ rÝd�« W
œ œbŠ Æ÷dF�UÐ W
—u� rÝd�« œËbŠ d�_UÐ ÁœËbŠ ·

Ò
dŽ Î̈«b¹bł ÎUHK� `²�≈

 ∫WO�U²�« rÝd�« d�«Ë√ l³²ð ÆrÝd�« w�  A  rŁ Z   Âb�²Ý≈ ¨·ËdF� ÌbK−� sL{ EA2 rÝôUÐ Save As d�_UÐ

 ©≤π∑ ¨∞® ¨©≤π∑ ¨≤±∞® ¨©∞ ¨≤±∞® ◊UIM�« w� d1Ë ©∞¨∞® WDIM�« s� √b³¹ Íc�« rOI²�*« j)« rÝ—√  ±

 ÆW¹«b³�« WDI½ v�≈ œuF¹ rŁ

 Æ©π∞¨ ±∏∞® WDIM�« w� wN²M¹Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ ÎULOI²�� ÎUDš rÝ—√  ≤

 Æ©±μ∞ ¨±∏∞® WDIM�« w� wN²M¹Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ ÎULOI²�� ÎUDš rÝ—√  ≥

 ÆwI�_« sŽ ≥∞ qO1Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ rK�±∏∞ t�uÞ ÎUDš rÝ—√  ¥

 Æ©±≤∞ ¨±μ∞®v�Ë_« WDIMK� W³�M�UÐ WO½U¦�« t²DI½  UOŁ«bŠ≈Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ ÎUDš rÝ—√  μ

ÆrK� ±μ∞ t�uÞ ÊuJ¹Ë ©π∞ ¨≤∞® WDIM�« s� vKŽú� ÎUOÝ√— ÎUDš rÝ—√  ∂

 UN²LÝ— w²�« ◊uD)« lOLł Ê√ Êü« b�Qð Æ©≤π∞ ¨≤∞∞® Ë ©±∞ ¨±∞® 5²DIM�« w� d1 ÎöOD²�� rÝ—√  ∑

ÆqOD²�*« «c¼ qš«œ UIÐUÝ

Æ©¥μ ¨¥¥® WDIM�« s� ÎU
öD½≈ ÎUOÝ√— rK� ≤∞∞ Ë ÎUOI�√ rK� ±∞∞ tŽö{√ Î«b¹bł ÎöOD²�� rÝ—√  ∏



∏± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ÆrK� ∏∑ U¼dD
 nB½Ë ©π∞¨π∞® U¼e�d� …dz«œ rÝ—√  π

 ÆrK� ±±∑ U¼dD
Ë ©π∞¨π∞® U¼e�d� …dz«œ rÝ—√  ±∞

 Æ©≥∞ ¨±≤∞®B ¨©≥∞ ¨∑∞®A tðbŽU
  UOŁ«bŠ≈ Íc�« ABC Ÿö{_« ÍËU�²*« YK¦*« rÝ—√  ±±

  ÆoÐU��« YK¦*« …bŽUIÐ UNFOLł „d²Að YO×Ð w½ULŁ qJý W¹UG� ¨ÆÆÆ¨lÐd� ∫WO�U²�«  UFKC*« rÝ—√  ±≤

 Æqš«b�« s� tŽö{√ f9 Èdš√ …dz«œ rÝ—√Ë ¨oÐU��« YK¦*« ”Ëƒ— w� d9 …dz«œ rÝ—√  ±≥

ÆWŁö¦�« ”Ëƒd�« w� d1 ”u
 rÝ— »dł  ±¥

 Æqš«b�« s� tŽö{√ f9 Èdš√ …dz«œ rÝ—√Ë ¨oÐU��« YK¦*« ”Ëƒ— w� d9 …dz«œ rÝ—√  ±μ

ÆWŁö¦�« ”Ëƒd�« w� d1 ”u
 rÝ— »dł  ±∂

ÆœU�uðË√ oKž«Ë ¨wÝUOI�«  «Ëœ_« j¹dý s� Save —e�« dIMÐ Wz—UD�«  «dOG²�« kHŠ≈  ±∑

 ∫WFł«dLK� WK¾Ý√
 XDG{ rŁ  d??�«Ë_«  …c�U½  w�  C  ·d×�«  X³²�  «–≈

 C  ·d×�«  X�b�²Ý« «–≈Ë ÆZ²M¹  «–UL� ‰Ušœù« ÕU²H�

ÆZ²M¹ «–UL� Line jš rÝd�« d�_ „cOHMð bMŽ

 —U�OK� sOLO�« s� Áœb×ð Íc�« —UÞù« sOÐ ‚dH�« U�

 „—UO²š« bMŽ sOLOK� —U�O�« s� Áœb×ð Íc�« —UÞù« vKŽ

 ÆWýUA�« vKŽ  UMzU� WŽuL−L�

 W
bÐ rÝd�«                  



∏≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

rÝd�« w	 —U×Ðô« ∫Y�U¦�« ”—b�«
oÐUÝ nK� `²	

 ©Desktop:\ACAD2002\LESSON2 Í√ w½U¦�« ”—b�« w� pLÝ— tÐ XON½√ Íc�« nKL�«® r¹b
 nK� `²H�

 œbŠ ÆSelect File —«u×�« lÐd� v�≈ qšbð sO²�U×�« w� p�H½ b−²� File>Open d²š« Ë√ Open d�_« V²�«

 ¨LESSON2 »uKDL�« nKL�« —U²�½ rŁ Desktop>ACAD2002 kH×�« bK−� Select File —«u×�« lÐd� w�

Æ©≤±≠¥® qJý w� dNE¹ UL�

Select File —«u×�« lÐd� ∫©≤±≠¥® qJý

 Zoom rÝd�« w	 —U×Ðù«
 Ë√ tLÝd½ U� vKŽ WÐdI� …dE½ ¡UI�ù Âb�²�¹ œU�uðË√ w� ÎôULF²Ý« d�«Ë_« d¦�√ bŠ√ u¼ rÝd�« w� —U×Ðù«

 UM� `O²¹ ·uÝ Zoom ¢bOF³ðØV¹dIð¢ ?Ð t�dFMÝ Íc�« d�_« «c¼ ÆWIÐU��« WM¹UFL�« v�« …œuF�« WO½UJ�≈ l� tOM³½

 ∫UNL¼√  «—UOš …œbFÐ rÝd�« w� —U×Ðù«



∏≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ∫rÝd�« s� WOŠU½ ‰uŠ Zoom Window WM¹UF*« V¹dI²�  √ 
∫w¼Ë p�– qLF� ‚dÞ …bŽ „UM¼

 d�«Ë_« …c�U½ w� dNEO� ¨wÝUOI�«  «Ëœ_« j¹dý s�   Zoom Window ¢—UÞ≈ V¹dIð ¢ —e�« jGCÐ  ±

 œU�uðË√ VO−²�O� dýRLK� d�¹_« —e�UÐ dIM�UÐ p�–Ë —UÞû� Specify first corner ¢v�Ë_« W¹Ë«e�« d²š«¢

 dNEðË WýUA�« tðœbŠ Íc�« —UÞù« úLOÝ ÌczbMŽ WKÐUI*« W¹Ë«e�« d²š« Í√ ¨:Specify opposite corner ?Ð

 …—u�c*« Èdš_« ‚dD�UÐ t�H½ »uKÝ_UÐ V¹dI²�« sJ1 UL� Ætðd²š« Íc�« —UÞù« qš«œ …d³J� WM¹UF*« p�

 ∫ÁU½œ√

  Æd�«Ë_« …c�U½ w� W  rŁ  Z  WÐU²JÐ  ≤

ÆWindow ¢ —UÞ≈¢ rŁ  Zoom ¢V¹dIð” View WOÝUOI�« WLzUI�« s� dIM�UÐ  ≥

 ∫Zoom Previous WIÐU��« WM¹UF*« v�≈ …œuFK�  »
wÝUOI�«  «Ëœ_« j¹dý s�   Zoom Previous ¢oÐU��« V¹dIð¢ —e�« jGCÐ  ±

ÆP  rŁ  Z  WÐU²JÐ  ≤

 v�≈  œU�uðË√  œuFO�  View>Zoom>Previous  Í√  View  WOÝUOI�«  WLzUI�«  s� ¢oÐU��«  V¹dIð¢ dIM�UÐ  ≥

ÆsOLO�« vKŽ ©≤≤≠¥®  qJý ¨WIÐU��« WM¹UF*« ÷dŽ

∫Zoom Realtime wIOI(« bOF³²�«ØV¹dI²�« Â«b�²Ý«  ?ł
 ÆwÝUOI�«  «Ëœ_« j¹dý s�  ¢wIOIŠ bOF³ð ØV¹dIð¢ —e�« jGC�UÐ  ±

 Æ5LO�« vKŽ ©≤≤≠¥® qJý ¨WO�Ozd�« WLzUI�« s� ¢wIOIŠ bOF³ðØV¹dIð¢ d²š« Ë√ Z  WÐU²JÐ  ≤

 r??Ýd??�« ¡e???ł ‚u???� d??ýR??L??�« l??{ Æ± …—U????ý≈ l??� W??Ýb??Ž q??J??ý v???�≈ d??ýR??L??�« dOG²¹ s??O??²??�U??×??�« U²K� w???�Ë

ÆbF²³¹  Áb−ð  vKŽ√  v??�≈  V×Ý«Ë  dI½«  rŁ  ¨»d²I¹  rÝd�«  b−ð  qHÝ√  v??�≈  V×Ý«Ë  dI½«  rŁ  t³¹dIð  »uKDL�«

∫ Pan Realtime  wIOI(« ‰u−²�« Â«b�²Ý«  œ 
ÆwÝUOI�«  «Ëœ_« j¹dý s�  ¢wIOI(« ‰u−²�«¢ —“ jGCÐ  ±

 Æ—U�O�« vKŽ ©≤≤≠¥® qJý ¨WO�Ozd�« WLzUI�« s� ¢wIOIŠ ‰u&¢ dIMÐ  ≤

 sOLO�« v�≈ V×Ý«Ë dI½« rŁ rÝd�« jÝË ‚u� dýRL�« l{ Æb¹ qJý v�≈ dýRL�« dOG²¹ sO²�U×�« U²K� w�Ë

 ÆrÝd�« qO�UHð s� b¹eL�« —UNþù qHÝ_« Ë√ —U�O�« Ë√ vKŽ_« Ë√



∏¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

   

©≤≤≠¥® qJý

 bOF³ðØV¹dIð ¨ Zoom Previous oÐU��« V¹dIð UNM�Ë View WOÝUOI�« WLzUI�« sOLO�« vKŽ ∫©≤≤≠¥® qJý

 ÆZoom Realtime  wIOIŠ

Pan Realtime  wIOI×�« ‰u−²�« Â«b�²Ý« —U�O�« vKŽ 

∫Zoom All qJ�« bOF³ðØV¹dIð Â«b�²Ý«  ?¼
 ÆrÝd�« —UÞ≈ sL{ tLÝdÐ XL
 U� q� dNE¹ YO×Ð WM¹UFL�« bOF³ð Ë√ V¹dI²Ð œU�uðË√ ÂuI¹ ¨A rŁ Z  V²�«

ÆÎUIÐUÝ ÁU½œ—Ë√ UL� Limits d�_«Ë rÝd�« œËbŠ n¹dFð bMŽ Â«b�²Ýù« WFzUý W�U×�« Ác¼

Æ`OðUHL�« WŠu� s� Esc ÕU²HL�« jG{« œU�uðË√ w� —U×Ðù« d�«Ë√ s� Ìd�√ Í√ s� ÃËd�K� ∫WEŠö�

©Ortho® b�UF²�« j/ Â«b�²Ý«
 Ë√ØË WOI�√ ô≈ dýRLK� W�dŠ b−ð ö� ÆrÝd�« WOKLŽ w� YK¦�Ë T …dD�� Â«b�²Ý« bOFÐ ÌbŠ v�≈ t³A¹ jL½

Æ©≤≥≠¥® qJý ¨jI� W¹œuLŽË WOI�√ ◊uDš rÝ— vKŽ dýRL�« ©ortho® b�UF²�« jL½ d³−¹Ë ÆWOÝ√—

 ÎUC¹√ p�– oOI×ð pMJL¹Ë ¨ÎÎö ÒFH� ÊU� «–≈ tKODFð Ë√ Îö ÒDF� ÊU� «–≈ b�UF²�« jL½ qOFH²Ð F8 ÕU²HL�« ÂuI¹

 ÆW�U×�« j¹dý w�  —e�« vKŽ dIM�UÐ Ë√ ¨CTRL+L wŠU²H� vKŽ jGC�UÐ

Status bar W�U×�« j¹dý ∫©≤≥≠¥® qJý



∏μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Direct Distance Entry  ◊uD)« rÝd� …dýU³*« WI¹dD�«
 «cN�Ë ÆWOÝ√— U�≈Ë  WOI�√  U�≈  dýRL�«  W�dŠ `³Bð  —e�«  vKŽ jGC�UÐ  b�UF²�«  jL½  q

=
F ÓHÔ½  U�bMŽ

 s� dýU³� ÌqJAÐ  U�U�L�« rOIKðË dýRL�« s� ÁU−ðù« b¹b×²Ð WOÝ√d�«Ë WOI�_« ◊uD��« rÝ— W�uN�Ð UMMJL¹

 Æ`OðUHL�« WŠu�

 ∫‰U¦�

 Â«b�²ÝUÐ p�–Ë Èd�O�«Ë vKH��« t²¹Ë«“ s� ÎU
öD½≈ ±∞∞×μ∞ ÁœUFÐ√ qOD²�� rÝd� WO�U²�«  ULOKF²�« l³ð«

 ¢jš rÝ—¢ ÍœU�uðË_« d�_«

Command: Line 

Specify first point:         v�Ë_« WDIM�« œbŠ

 bOFÐ ©p�– q³
 v²Š Ë√ œU�uðË√ d�√ cOHMð ¡UMŁ√ 
Ì
l{Ë Í√ w� tKODFð Ë√ tKOFHð sJL¹® b�UF²�« jL½ UM¼ q

=
F ÓHÔ½

 w²�« W¹«b³�« WDI½ sOL¹ v�≈ dýRL�« tłË ÆWOÝ√— Ë√ WOI�√ dýRL�« W�dŠ `³B²� j��« pLÝd� v�Ë_« WDIM�« b¹b×ð

 V²�« rŁ —U�O�« v�≈ dýRL�« tłË rŁ ±∞∞ V²�«Ë vKŽ_« v�≈ dýRL�« tłË rŁ μ∞ V²�« rŁ UNM� XIKD½«

 «cJ¼ ÆC V²�« rŁ μ∞

Specify first point:<Ortho on>       v�Ë_« WDIM�« œbŠ

Specify next point or [Undo]: 50         sOLOK� dýRL�«

Specify next point or [Undo]: 100         vKŽú� dýRL�«

Specify next point or [Close/Undo]: 50       —U�OK� dýRL�«

Specify next point or [Close/Undo]: C

 Æ…bŠË ±∞∞ tŽUHð—«Ë …bŠË μ∞ t�uÞ ¨tMOFÐ qOD²�� u¼ t²LÝ— U� Ê√ V�UD�« Íe¹eŽ kŠöð



∏∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 s¹—ULð
  Direct Distnce Entry◊uD��« rÝd� …dýU³L�« WI¹dD�«  Â«b�²ÝUÐ  ©≤¥≠¥® qJý ¨WOðô« ‰UJý_« rÝ—«

sOKJA�« rÝd� b�UF²�« jL½ Âb�²Ý« ∫©≤¥≠¥® qJý

∫ ◊UA½
ÆÎUC¹√  UOŁ«bŠù« Â«b�²ÝUÐ ‰UJý_« Ác¼ rÝ—«

∫tO³Mð

 WNł s� sJ� ÆWIKDL�« UNLO
 œb×ð w²�«  U�U�L�UÐ WOÝ√—Ë WOI�√ ◊uDš rÝ— vKŽ „bŽU�¹ b�UF²�« jL½ qOFHð 

  ÆWO³�M�«  UOŁ«bŠû� ÎUI�Ë pLO
 XKšœ√ U� «–≈  U¼U−ðùUÐ Â«e²�ù« ÂbŽ b�UF²�« jL½ qOFHð l� pMJL¹ ¨Èdš√

Coordinate Display  UOŁ«bŠù« lÐd� Â«b�²Ý«
 Èd�O�« W¹Ë«e�« w� W�U×�« j¹dý w� œułuL�«  UOŁ«bŠù« lÐd� ÊS� rÝd�« WIDM� w� dýRL�« X�dŠ ULK�

  WO³�½ Ë√ WO³D
 Ë√ ¨©≤μ≠¥® qJý WIKD� WOð—UJ¹œ  UOŁ«bŠ≈ W�ôbÐ dýRL�« l
u� ÷dF¹ WýUA�« s� WOKH��«Ë

 Æq�√ WDI½  UOŁ«bŠ≈ v�≈ W³�M�UÐ pLÝd� dýRL�« l
u� œU−¹≈ p� `O²¹ UL� ¨©≤∂≠¥® qJý

 Ë√ WIKD� WOð—UJ¹œ  UOŁ«bŠ≈ ÂUE½ ÷dF¹ YO×Ð  UOŁ«bŠù« lÐd�  «œ«bŽ≈ VOKIð ÷dFÐ F6 ÕU²HL�« ÂuI¹

 vKŽ dIM�UÐ Ë√ ¨CTRL+D wŠU²H� vKŽ jGC�UÐ ÎUC¹√ p�– oOI×ð pMJL¹Ë ¨qLF�« sŽ n
u²¹ Ë√ WO³�½ WO³D


ÆW�U×�« j¹dý w�  UOŁ«bŠù« lÐd�



∏∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 w� Ëb³¹ UL� rÝd�« dýR� l
u�  UOŁ«bŠ≈ ∫©≤∂≠¥® qJý

ÆU� UDš rÝd½ U�bMŽ  UOŁ«bŠù« lÐd�
  

 UL� rÝd�« dýR� l
u�  UOŁ«bŠ≈ ∫©≤μ≠¥® qJý

 Æ¡wý Í√ rÝd½ ô U�bMŽ  UOŁ«bŠù« lÐd� w� Ëb³¹

Object Snap  UMzUJ�« VŁË
 v�≈ Ãu�u�« w� UMðbŽU�L�  UMzUJ�« VŁË Â«b�²Ý« qBH�« «c¼ w� rKF²²Ý

 w� WOL¼_« WG�UÐ …«œ√ w¼ ¢ UMzUJ�« VŁË ¢ …«œ_« Ác¼ ÆWMOFL�« WOÝbMN�« WDIM�«

 …dz«œ W¹√ ôË ÁUMLÝ— jš Í√ jÐd½ Ê√ ‰ËU×½ r� WIÐU��« ”Ë—b�« wH� ÆœU�uðË√

 U¼e�d� ÊuJ¹ …dz«œ rÝdÐ Vždð p½√ qO�ð ÆWýUA�« vKŽ …œb×� ◊UI½ l� W−ðU½

 nO� Ædš¬ jš l� tFÞUIð WDI½ Ë√ tHB²M� Ë√ WýUA�« vKŽ ÂuÝd� jš W¹UN½ WDI½

 VŁu�« ◊UL½√ Â«b�²ÝUÐ u¼ »«u−�« ÆœU�uðË√ w� ÁcOHMð r²¹ nO�Ë p�– qLF½

 ◊UIM�« v�≈ VŁu�« vKŽ dýRL�« d³−¹ YOŠ fOÞUMGL�« t³Að w²�«Ë Object Snap

Æa�«ÆÆÆ”uI�« Ë√ j��« nB²M� Ë√ …dz«b�« e�dL� …œb×L�« WOÝbMN�«

 Â«b�²Ý« w¼ wÝUOI�«  «Ëœ_« j¹dý w� VŁu�« jL½ qOFH²� WI¹dÞ qC�√

 WLzUI�« Ác¼ vKŽ jGC�« r²¹ –≈ Æ©≤∑≠¥® qJý ¨VŁu�« ◊UL½√ s� WŽdH²L�« WLzUI�«

 Æ»uKDL�« VŁu�« jL½ UNM� —U²�½ rŁ UNz«eł√ q� qHÝú� ŸdH²ð Í√ ‰b�M²�

 ◊UL½√ WLzU
 ∫©≤∑≠¥® qJý

 j¹dý s� WŽdH²L�« VŁu�«

wÝUOI�«  «Ëœ_«

 WI¹dD�« Ác¼ Æ©≤∏≠¥® qJý ¨dL²�� qJAÐ WýUA�« vKŽ t²O³¦ðË VŁu�« ◊UL½√  «Ëœ√ j¹dý qOFHð sJL¹ UL�

 w� WOKLŽ d¦�_« w¼ ¨Èdš√ WNł s� UNMJ� ¨WýUA�« vKŽ Î«eOŠ qGA¹  «Ëœ_« j¹dý Ê_ UN�«b�²Ý« qCH¹ ô

 ¢÷dŽ¢ WLzU
 s� ToolbarsÆÆÆ¢ «Ëœ_« WÞdý√¢ d²š« ¨p�cÐ ÂUOIK� Æœb−�« sOLKF²LK� W�Uš Â«b�²Ýô«



∏∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 VŁu�« ◊UL½√ j¹dý dNEO� ¨©Object Snap® ¢ UMzUJ�« VŁË¢  Customize  —«u×�« lÐd� s� d²š«Ë ¨View

Æ©≤∏≠¥® qJý w� UL�

Object Snap VŁu�« ◊UL½√ j¹dý ∫©≤∏≠¥® qJý

W¹eOK$ô« WGK�UÐ UNð«—UB²š«Ë  UMzUJ�« VŁË vMF�Ë  «—UOš
 ∫UNM� …bŠ«Ë q� vMF�Ë  UMzUJ�« VŁË  «—UOš r¼_ Õdý wK¹ ULO�

.a�«ÆÆÆ”u
 Ë√ jš W¹UN½ v�≈ dýRL�« VŁË vKŽ ENDpoint W¹UNM�« WDI½ v�≈ VŁu�« bŽU�¹

.a�«ÆÆÆ”u
 Ë√ jš nB²M� v�≈ dýRL�« VŁË vKŽ MIDpoint nB²ML�« WDI½ v�≈ VŁu�« bŽU�¹

ÆsOFÞUI²� sOMzUJ� WOKF� lÞUIð WDI½ v�≈ dýRL�« VŁË vKŽ INTersection lÞUI²�« v�≈ VŁu�« bŽU�¹

 ÊUMzU� UNO� lÞUI²¹ w²�« WDIM�« v�≈ dýRL�« VŁË vKŽ APParent intersection d¼UE�« lÞUI²�« v�≈ VŁu�« bŽU�¹

ÆUL¼U½œ Òb� u� ULO�

ÆÁU½œ Òb� u� ULO� szUJ�« qJý Áœb×¹ Íc�« ÁU−ðô« w� wAL¹ dýRL�« qFł vKŽ EXTension œ«b²�ô« v�≈ VŁu�« bŽU�¹

Æa�«ÆÆÆ”u
 Ë√ …dz«œ e�d� v�≈ dýRL�« VŁË vKŽ CENter e	dL�« v�≈ VŁu�« bŽU�¹

Æ—ËU×� l� ”uI�« Ë√ …dz«b�« lÞUIð l
u� v�≈ dýRL�« VŁË vKŽ QUADdrant …dz«b�« lÐ— v�≈ VŁu�« bŽU�¹

ÆÍdz«œ ”u
 Ë√ …dz«œ vKŽ ”ULL�« l
u� v�≈ dýRL�« VŁË vKŽ TANgent ”ULL�« v�≈ VŁu�« bŽU�¹

ÆY W¹œUB�«Ë X WOMO��«  UOŁ«bŠù«

 rÝd¹ YO×Ð ”u
 Ë√ …dz«œ Ë√ jš vKŽ l
u� v�≈ dýRL�« VŁË vKŽ PERpendiclar b�UF²L�« v�≈ VŁu�« bŽU�¹

 Æ”uI�« p�– Ë√ …dz«b�« pKð Ë√ j��« p�– vKŽ Î«b�UF²� ÎUDš

Æjš ÁU−ðô ÎU¹“«u� wAL¹ dýRL�« qFł vKŽ PARallel Í“«uL�« v�≈ VŁu�« bŽU�¹

Æ©block® WK²J�« Ã«—œ≈ WDI½ Ë√ WÐU²JK� q�_« WDI½ v�≈ dýRL�« VŁË vKŽ INSertion Ã«—œù« v�≈ VŁu�« bŽU�¹

ÆÂuÝdL�« qJA�« jI½ s� WDI½ v�≈ dýRL�« VŁË vKŽ NODe …bIŽ v�≈ VŁu�« bŽU�¹

∫WEŠö�

 ·Ëd×�UÐ  ÁöŽ√ …œ—«u�«   «—UB²šù« V²Jð Ê√  d�«Ë_« …c�U½  w� VŁu�«  ◊UL½_ p�«b�²Ý« bMŽ lOD²�ð

 ÆjL½ qJ� …dO³J�« Àö¦�« W¹eOK−½ù«



∏π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

s¹—ULð

ÆoKD*«  UOŁ«bŠù« ÂUE½ Â«b�²ÝUÐ qJA�« rÝ—√   ≤              …dýU³L�« WI¹dD�UÐ w�U²�« qJA�« rÝ—√   ±

ÆDirect Distance Entry ◊uD��« rÝd�         

        

oKDL�«  UOŁ«bŠù« ÂUEM� ÎUI�Ë W
bÐ rÝd�«   ◊uD��« rÝd� …dýU³L�« WI¹dD�UÐ rÝd�«

 Æw³�M�«  UOŁ«bŠù« ÂUEM� ÎUI�Ë 5IÐU��« 5M¹dL²�« rÝ—√  ≥



π∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ÆB WDIMK� ôu�Ë WŽU��« »—UIŽ l� A(10,20) WDIM�« s� ÎU
öD½≈  ◊uDš WK�K�� ·d×M*« t³ý rÝ—√  ¥
 t³ý rÝ— √b³½ WDI½ Í√ sL� ◊uD��« rÝd� Direct Distance Entry …dýU³L�« WI¹dD�« Â«b�²Ý« U½œ—√ «–≈

 Æ·d×ML�«

 Æ©¥® s¹d9 w� qJAK� qzU*«Ë wKH��« 5FKC�« f9Ë rK� ≥≤ U¼dD
 nB½ …dz«œ rÝ—√  μ

 ÊUOI�_« WŁö¦�« Ÿö{_« f9 Èdš√ …dz«œ rÝ—√ rŁ qzU*«Ë ÊUOI�_« WŁö¦�« Ÿö{_« f9 …dz«œ rÝ—√  ∂

ø5²¾�UJ²� …dOš_« W�U(« w� ÊUðdz«b�« q¼ Æ©¥® s¹d9 w� qJAK� wÝ√d�«Ë



π± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 tðU¹u²×�Ë rÝd�«  «Ëœ√ j¹dý ∫lÐ«d�« ”—b�«

Draw rÝd�« WLzU
 ∫©≥∞≠¥® qJý Draw Toolbar rÝd�«  «Ëœ√ j¹dý ∫©≤π≠¥® qJý

  «Ëœ√ j¹dý UM�b�²Ý« UL� ¨d�«Ë_« …c�U½ w� UN²ÐU²JÐ rÝd�« d�«Ë√ iFÐ vKŽ ”Ë—œ s� o³Ý ULO� UM�dFð

 rKFð UM¼ qLJMÝ Æ UFKCL�«Ë dz«Ëb�«Ë  öOD²�L�«Ë ◊uD��U� WOÝUÝ_« rÝd�« d�UMŽ iFÐ rÝd� rÝd�«

 WÝUOI�« WLzUI�« sL{ Ë√ ©≤π≠¥® qJý ¨rÝd�«  «Ëœ√ j¹dý sL{ U�≈ …œb×L�«Ë …—uNAL�« rÝd�« d�«Ë√ VKž√

 Æ©≥∞≠¥® qJý ¨ Draw ¢rÝd�«¢

 Æd�¹Ë W�uN�Ð œb×L�« d�_« ¡UI²½« vKŽ …bŽU�L�« v�≈ ·bN¹Ë Î̈UOÝUÝ√ Î«—“ ±∂ s� rÝd�«  «Ëœ√ j¹dý n�Q²¹

 lDI�«Ë arc Ídz«b�« ”uI�«Ë point WDIM�U� œU�uðË√ w� …—uNAL�« rÝd�« d�«Ë√ WOIÐ vKŽ ·dF²�« qLJMÝ ¨Êô«

 ÆSpline w×¹dA�« j��« rÝ—Ë MtextË Dtext œU�uðË√ w� ’uBM�« WÐU²� p�– v�≈ ÎU�UC� Ellipse h
UM�«



π≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

WDI½ rÝ—
 XL
  ULN�  Î«bł  …dOG�  œU�uðË√  w�  WDIM�«  vI³ð  «–UL�  d�H¹  U�  «c¼Ë  ¨œUFÐ√  t�  fO�  wÝbM¼  szU�  WDIM�«

 t�«b�²Ýô lłdL� œU�uðË√ w� WDIM�« Â«b�²Ý« sJL¹ Æ©zoom® dO³JðØdOGBð d�_« Â«b�²ÝUÐ UNM� »«d²
ôUÐ

Æ…b¹bł  UMzU� rO�IðË ¡UA½≈ w� bFÐ ULO�

 po  V²�« Ë√® œU�uðË√ d�«Ë√ …c�U½  w� point  V²�« Ë√ ¨rÝd�«  «Ëœ√ j¹dý s�  —e�«  dI½«  WDI½ rÝd�

ÆWO�Ozd�« WLzUI�« s� Draw>Point>Single Point d²š« Ë√ ¨©p�c� Î«—UB²š«

  UOŁ«bŠù« ‰UšœSÐ UNF
u� b¹b×²Ð œU�uðË√ w� ©±∞∞ ¨¥μ® UNðUOŁ«bŠ≈ WDI½ ¡UA½« WI¹dÞ q¦L¹ wðü« ‰U¦L�«Ë

∫WIKDL�« WOð—UJ¹b�«

Command: Po 

POINT

Current point modes:  PDMODE=0  PDSIZE=0.0000

Specify a point: 45,100 

 nO� ¨rÝd�« WýUý vKŽ WDIM�« Õu{Ë ÂbŽ XEŠô pKF�

 ¨p�c� Æ÷dŽ ôË ‰uÞ ô t� fO� wÝbM¼ szU� WDIM�«Ë ô

 Ë√  jš  ‚u�  ÊuJð  ÊQ??�®  dš¬  szU�  œu??łË  l�  wH²�ð  WDIM�U�

 rJ×²K� WI¹dÞ œU�uðË√ d�u¹ ¨WKJAL�« Ác¼ q×� Æ©Îö¦� t²×ð

 Ëb³ð YO×Ð Point Style  ¢WDIM�«  jL½¢ vL�ð WDIM�«  dNELÐ

 WK¹uÞ  UÞdAÐ WOKFH�« WDIM�« ‰«b³²ÝUÐ p�–Ë ¨ÎUŠu{Ë d¦�√

 ÁU³²½ù« V−¹ «c¼ l�Ë Æa??�«ÆÆÆÆ dz«Ëœ Ë√  UFÐd� Ë√ ÎUO³�½

 v�≈  rÝd�«  WýUý vKŽ WDIM�«  dNE� q¹u×ð wMF¹  p�– Ê√  v�≈

 ¨W²³�« œUFÐ√ UN� fO� WDI½ WDIM�« vI³ð ULMOÐ dš¬ wÝbM¼ qJý

ÆWŽU³D�« bMŽ W�Uš

 Point Style ¢WDIM�« jL½¢  —«u×�« lÐd� vKŽ ‰uB×K�

 V²�«  Ë√  Format>Point Style  WO???�Ozd�«  W?????LzUI�«  s�  d²š«

 Æ©≥±≠¥® qJý ¨tOKŽ qB×²� d�«Ë_« …c�U½ w� ddptypePoint Style ¢WDIM�« jL½¢ —«u×�« lÐd� ∫©≥±≠¥® qJý



π≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 lÐd� w� b¹b−�« jLM�« vKŽ dIM�« VKD²¹ p�– ÊS� wÐdC�« jLM�« v�≈ wDIM�« jLM�« s� WDIM�« jL½ U½dOž «–≈

 ∫©≥≤≠¥® qJA�« w� UL� »dC�«  «—UýSÐ j��« vKŽ ◊UIM�« ‰b³²�ð ¨ÌczbMŽË ¨©≥±≠¥® qJý ¨—«u×�«

©qHÝ√® »d{ …—Uý≈ v�≈ ©vKŽ√® WDI½ s� UN�bF¹ WDIM�« jL½ dNELÐ rJ×²�«∫©≥≤≠¥® qJý

Ídz«b�« ”uI�« rÝ—
 ”uI�«  v�≈  U½dE½  «–≈  Æ…œb×�  «—UO²šô ÎUI�Ë  tLÝ— sJL¹  …d??z«œ  s� Î«¡e??ł qJA¹ wÝbM¼ szU�  ”uI�«

 p�c�Ë Æ”uI�« rÝdðË ·dFð WLÝd�« vKŽ …œułuL�«  UODFL�« s� WŁöŁ W¹√ Ê√ b−½ ¨©≥≥≠¥® qJý ¨ÂuÝdL�«

 Æ”uI�« rÝd� ÎÓUÝUÝ√ qJA²�  UODFL�« Ác¼ s� WŁöŁ W¹√ jÐd½ Ê√ lOD²�½

 Ídz«b�« ”uI�« rÝ—  UODF�∫©≥≥≠¥® qJý

 Ë√ ¨©≤π≠¥® qJý ¨rÝd�«  «Ëœ√ j¹dý s� ”uI�« rÝ— sJL¹ œU�uðË√ d�«Ë√ VKž√ w� ‰U×�« u¼ UL�Ë

 d�«Ë_« …c�U½ w� WÐU²� v²Š Ë√ ¨©≥¥≠¥® qJý ¨WOÝUOI�« WLzUI�« s�



π¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Draw WOÝUOI�« WLzUI�« s� Ídz«b�« ”uI�« rÝ—∫©≥¥≠¥® qJý

 ∫©≥¥≠¥® qJý dE½√ ¨Ídz«b�« ”uI�« rÝd� WMJLL�«  UL²Šù«

∫WOÝUOI�« WLzUI�« s� Ídz«b�« ”uI�« rÝd�

 Æ”uI�« vKŽ ◊UI½ ÀöŁ  

 ÆW¹UNM�« WDI½Ë ”uI�« e	d� ¨W¹«b³�« WDI½  
 ÆwÝuI�« ŸUDI�« W¹Ë«“Ë ”uI�« e	d� ¨W¹«b³�« WDI½  

 Æ”uI�« ‰uÞË ”uI�« e�d� ¨W¹«b³�« WDI½  

 ÆwÝuI�« ŸUDI�« W¹Ë«“Ë W¹UNM�«Ë W¹«b³�« w²DI½  

 ÁU&ô«Ë W¹UNM�«Ë W¹«b³�« w²DI½  

 ÆdDI�« nB½Ë W¹UNM�«Ë W¹«b³�« w²DI½  
 ÆW¹UNM�« WDI½Ë W¹«b³�« WDI½ ¨”uI�« e�d�  

 ÆwÝuI�« ŸUDI�« W¹Ë«“Ë W¹«b³�« WDI½ ¨”uI�« e�d�  

 Æ”uI�« ‰uÞË W¹«b³�« WDI½ ¨”uI�« e�d�  

ÆoÐUÝ ”u
 Ë√ jš s� ”u
 rÝ— WFÐU²�  

 Æp�HMÐ UNOKŽ oO³D²�« W�uN�Ð pMJLO�  ôU×�« WOIÐ U�√ ¨jI� o�Už ÌÊuKÐ WŽu³DL�«  ôU×�« vKŽ UM¼ e�dMÝË



πμ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

”uI�« vKŽ ◊UI½ ÀöŁ b¹b×²Ð      ∫ÎôË√  
 ÆtOKŽ W¦�UŁ WDI½Ë t²¹UN½ WDI½Ë ”uI�« W¹«bÐ WDI½ l
u� sŽ WK�UJ�«  U�uKFL�«  d�uð «–≈ ”u
 rÝ— sJL¹

 WO{«d²�ô« WI¹dD�« UN½_ ¨”uI�« rÝd� UN³žd¹ w²�« WI¹dD�UÐ œU�uðË√ ⁄öÐ≈ v�≈ Âb�²�L�« ÃU²×¹ ô W�U×�« Ác¼ w�Ë

 UNO� dL¹ rÝd�« w� WMOF� ◊UI½ v�≈ VŁuK�  UMzUJ�« VŁË Â«b�²Ý« v�≈ Âb�²�L�« ÃU²×¹ VKž_« vKŽË ÆDefault

 wN²M¹ rŁ ÌÊUŁ jš nB²M� w� dL¹Ë ÂuÝd� jš W¹UN½ s� √b³OÝ tLÝ— »uKDL�« ”uI�« Ê√ UM{d²�« «–≈ Æ”uI�«

 ¨p�– cOHM²� Æb¹b×²�UÐ ”uI�« «c¼ ¡UA½≈ WI¹dÞ `{u¹ w�U²�« q�K�²�« ÊS� WýUA�« vKŽ …œułu� …dz«œ lÐ— w�

   ∫wðQ¹ UL�  «uD��« l³ð«Ë wz«uAŽ ÌqJAÐ …dz«œË sOKBHM� sODš rÝ—«

Command: Arc 

ARC Specify start point of arc or [Center]: END    U¼dI½«Ë »uKDL�« j��« W¹UN½ s� »d²
« 

Specify second point of arc or [Center/End]: MID      ÁdI½«Ë w½U¦�« j��« nB²M� s� »d²
«

Specify end point of arc: QUAD        œb×L�« UNFÐ— dI½«Ë WÐuKDL�« …dz«b�« s� »d²
«

 ÊU� «–≈ U�√ ÆrÝd�« WýUý vKŽ …—U²�L�« ◊UIM�« l
«u� sOOF²� WHK²�L�« VŁu�« ◊UL½√ Âb�²�ð ¨VKž_« vKŽË

  ∫w�U²�« q�K�²�« l³²½ UM½S� wz«uAŽ ÌqJAÐ WýUA�« vKŽ œb×²ð ◊UI½ ÀöŁ w� dL¹ ”u
 rÝ— »uKDL�«

Command: Arc

ARC Specify start point of arc or [Center]:   rÝd�« WýUý vKŽ v�Ë_« WDIM�« dI½« 

Specify second point of arc or [Center/End]:     rÝd�« WýUý vKŽ WO½U¦�« WDIM�« dI½«

Specify end point of arc:        rÝd�« WýUý vKŽ W¦�U¦�« WDIM�« dI½« 

 …dýU³� rOI�« pKð rIK½ UM½S� UNðUOŁ«bŠSÐ …œb×� WŁöŁ Ì◊UI½ w� dL¹ tLÝ— »uKDL�« ”uI�« ÊU� «–≈ Î̈«dOš√Ë

 ÆœU�uðË_ WÐU−²Ý«

∫‰U¦�

 ÆA(20,19)، B(70,60) ،C(140,25)  WO�U²�« WŁö¦�« ◊UIM�« w� dL¹ Íc�« Ídz«b�« ”uI�« rÝ—«

Command: Arc 

ARC Specify start point of arc or [Center]: 20,19 

Specify second point of arc or [Center/End]: 70,60 

Specify end point of arc: 140,25 



π∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Áe�d�Ë ”uIK� W¹UNM�«Ë W¹«b³�« w²DI½ b¹b×²Ð      ∫ÎUO½UŁ  
 q¦L¹ Æ”uI�« e�d� ULN� ÎU�UC� W¹UNM�«Ë W¹«b³�« w²DI½ sŽ WK�UJ�«  U�uKFL�«  d�uð «–≈ ”uI�« rÝ— sJL¹

∫b¹b×²�UÐ ”uI�« «c¼ ¡UA½« WI¹dÞ w�U²�« q�K�²�«

Command: Arc 

ARC Specify start point of arc or [Center]:    rÝd�« WýUý vKŽ v�Ë_« WDIM�« dI½«

Specify second point of arc or [Center/End]: C tKOFH²� ”uI�« e�d� —UO��« œb×ð Í√

Specify center point of arc:     ”uI�« e�d� ÊuJ²Ý w²�« WDIM�« dI½« 

Specify end point of arc or [Angle/chord Length]:    rÝd�« WýUý vKŽ WO½U¦�« WDIM�« dI½« 

tŽUD� W¹Ë«“ rŁ Áe�d� ¨t¹«b³�« WDI½ b¹b×²Ð      ∫ÎÎU¦�UŁ  
 q¦L¹ Æ”uI�« ŸUD
 W¹Ë«“Ë ”uI�« e�d� ¨W¹«b³�« WDI½ sŽ WK�UJ�«  U�uKFL�«  d�uð «–≈ ”uI�« rÝ— sJL¹

∫b¹b×²�UÐ ”uI�« «c¼ ¡UA½« WI¹dÞ w�U²�« q�K�²�«

Command: Arc

ARC Specify start point of arc or [Center]:   rÝd�« WýUý vKŽ v�Ë_« WDIM�« dI½«

Specify second point of arc or [Center/End]: C         tKOFH²� ”uI�« e�d� —UO��« œbŠ

Specify center point of arc:             Áe�d� ÊuJ²Ý w²�« WDIM�« dI½« 

pecify end point of arc or [Angle/chord Length]: a        tKOFH²� W¹Ë«e�« —UOš œbŠ 

Specify included angle: 60

ÆWŽU��« »—UIŽ fJŽ ÊuJ¹ W³łuL�« W¹Ë«e�« ”UO
 Ê√ d�c�UÐ d¹b−�« r�Ë

ÁdD� nB½ rŁ W¹UNM�«Ë W¹«b³�« w²DI½ b¹b×²Ð     ∫ÎUFÐ«—  
 Æ”uI�« dD
 nB½ ULN� ÎU�UC� W¹UNM�«Ë W¹«b³�« w²DI½ sŽ WK�UJ�«  U�uKFL�«  d�uð «–≈ ”u
 rÝ— sJL¹

∫b¹b×²�UÐ ”uI�« «c¼ ¡UA½« WI¹dÞ w�U²�« q�K�²�« q¦L¹

Command: Arc

ARC Specify start point of arc or [Center]:   rÝd�« WýUý vKŽ v�Ë_« WDIM�« dI½«

Specify second point of arc or [Center/End]: E         W¹UNM�« WDI½ —UO��« œbŠ 



π∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Specify end point of arc:      rÝd�« WýUý vKŽ WO½U¦�« WDIM�« dI½«

Specify center point of arc or [Angle/Direction/Radius]: R tKOFH²� dDI�« nB½ —UO��« œbŠ

Specify radius of arc: 100

Spline w×¹dA�« j)«
 Ác¼ sOÐ  jÐd�UÐ  tLÝ— r²¹Ë ÕuD��«  Ë√   UOM×ML�«  n�u� w{U¹— dO³F²� …œb×� ◊UI½  jÐd¹  Ìs×M� jš

   ÆWýUA�« vKŽ ÂuÝd� lÐd� ©”Ëƒ—® ◊UI½ sOÐ jÐd¹ ÎUO×¹dý ÎUDš rÝdð Ê√ ‰ËUŠ Æ◊UIM�«

Command: Spline 

Specify first point or [Object]:       v�Ë_« ©”√d�«® WDIM�« dI½«

Specify next point:            WO½U¦�« WDIM�« dI½«

Specify next point or [Close/Fit tolerance] <start tangent>:       W¦�U¦�« WDIM�« dI½«

Specify next point or [Close/Fit tolerance] <start tangent>:     WFÐ«d�« WDIM�« dI½«

Specify next point or [Close/Fit tolerance] <start tangent>: C  (Close) 

Specify tangent: 

 ÊUHK²�� ULNMJ� WFÐ—_« lÐdL�« ◊UI½ s� dLð w²�« …dz«b�« s� »d²I¹ ÂuÝdL�« w×¹dA�« vM×ML�« Ê√ b¼UA²Ý

  ÆWHK²�L�« VŁu�« ◊UL½√ Â«b�²ÝUÐ r²¹ b
 jIM�« —UO²š« Ê√ v�≈ ÁU³²½ù« V−¹ ÆÈdš√  UH� w�

 h�UM�« lDI�« Ë√ ÍËUCO³�« qJA�« rÝ—
 sO²DIM�« sOÐ W�U�L�« Æt� ÎUŽUÐ—√ qJAð ◊UI½ lÐ—√ s� tOKŽ ◊UI½ ÀöŁ b¹b×²Ð ÍËUCO³�« qJA�« rÝ— r²¹

 Minor Íu½U¦�« —u×L�« dD
 nB½ W¦�U¦�« WDIM�« dIMÐ œb×½Ë Major axis d³�_« —u×L�« qJAð WO½U¦�«Ë v�Ë_«

 ÆÂuÝd� qOD²�� Ÿö{√  UHBM� qJAð ÀöŁ ◊UI½ w� dL¹ Íc�« ÍËUCO³�« qJA�« rÝ—« ÆAxis

 ÍËUCO³�« qJA�« rÝ— ∫©≥μ≠¥® qJý



π∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center]: MID of sOLO�« vKŽ qOD²�L�« lK{ nB²M� dI½«

Specify other endpoint of axis: MID of        —U�O�« vKŽ qOD²�L�« lK{ nB²M� dI½«

Specify distance to other axis or [Rotation]:         vKŽ_« w� qOD²�L�« lK{ nB²M� dI½«

∫‰U¦�

Æ…bŠË μ∞ dG�_« Á—u×� ©‰uÞ®Ë …bŠË ±∞∞ d³�_« Á—u×� ©‰uÞ® Íc�« ÍËUCO³�« qJA�« rÝ—«

Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center]:      WýUA�« vKŽ U� WDI½ dI½« 

Specify other endpoint of axis: @100<0 

Specify distance to other axis or [Rotation]: @25<90 

∫w�U²�« ‰U¦L�« w� UL� Áe�d� s� bO�UÐ ÍËUCO³�« qJA�« rÝ— sJL¹Ë UL�

∫‰U¦�

Æ…bŠË ∂∞ dG�_« Á—u×� ©‰uÞ®Ë …bŠË ±≤∞ d³�_« Á—u×� ©‰uÞ® Íc�« ÍËUCO³�« qJA�« rÝ—«

Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center]:  C          e�d�¢ —UO��« œb×½¢

Specify center of ellipse:       ÍËUCO³�« qJAK� wÝbM¼ e�dL� WýUA�« vKŽ U� WDI½ dI½« 

Specify endpoint of axis: @60<0             d³�_« dDI�« nB½ ‰uD� sOLO�« vKŽ WDI½ vB
√ œbŠ

Specify distance to other axis or [Rotation]: @30<0 

 dG�_« dDI�« nB½ ‰uD� vKŽ_« w� WDI½ vB
√ œbŠ

 Hatch qOKE²�« d�√
 WŽuL−� vKŽ œU�uðË√ Íu²×¹ –≈ Æ…œb×� qOKEð Ã–UL½Ë ◊UL½√ o�Ë WIKGL�«  UŠU�L�« qOKE²Ð d�_« «c¼ ÂuI¹

 Hatch —e�« dI½ Ë√ Draw>Hatch WO�Ozd�« WLzUI�« s� Hatch d�_« q
=
F ÓHÔ½Ë ¨©Hatch pattern® qOKE²�« Ã–UL½ s�

 ∫V²J½ Ë√ rÝd�«  «Ëœ√ j¹dý s�

Command: Bhatch ( Bh )

∫ UNM� —U²�M� Boundary Hatch qOKE²�« œËbŠ —«u×�« lÐd� v�≈ p�– pKšb¹



ππ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

¢qOKE²�« œËbŠ¢—«u×�« lÐd� ∫©≥∂≠¥® qJý

 User defined —U²�M� Type ¢jLM�«¢

 Wł—œ ¥μ —U²�½ Angle ¢W¹Ë«e�«”

 …bŠË ≤[μ œb×M� Spacing qOKE²�« ◊uDš sOÐ ¢W�U�L�«¢

 qOKE²�« WIDML� ÎUO�Ë√ Î«dEM� cšQ½ Ê√ p�– bFÐ lOD²�½Ë ÆqKE²Ý w²�« WŠU�L�« eOŠ qš«œ WDI½ —U²�½ rŁ

 ‰Ušœù« ÕU²H� jGC½ UMðU³KÞ l� WI�«u²� WLIKL�«  UODFL�« Ê√ U½błË «–≈ ÆqHÝ_« w� Preview —e�« vKŽ dIM�UÐ

  ÆsOLO�« vKŽ OK

 ’uBM�« ‰Ušœ≈
∫UL¼ sO²MŁ« sO²GOBÐ œU�uðË√ w� ’uBM�« ‰Ušœ≈ r²¹

Dtext d�_UÐ Single Text  œdHM� jš
 √b³ð  …œUF�UÐË Æl³Dð U�bMŽ W×{«Ë WÐU²J�«  ÊuJðË ÆbŠ«Ë WÐU²� jš s� d¦�√  rÝdÐ d�_« «c¼ p� `L�¹

 hMK� Èd�O�«Ë WOKH��« W¹Ë«e�« w� ÎUO{«d²�« œb×²ð w²�«Ë Start Point ¢W¹«b³�« WDI½¢ w¼ WMOF� WDI½ s� WŽU³D�«

      ÆW¹«b³�« ◊UL½√ s� Í√ —UO²š« r²¹ Ë√

Command: dt 

DTEXT

Current text style:  “ARIAL”  Text height:  3



±∞∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Specify start point of text or [Justify/Style]:    hM�« W¹«bÐ WDI½ U½œbŠ UM¼

Specify height <3>:            «bŠË ≥ ?Ð œb×ð WÐU²J�« ŸUHð—«

Specify rotation angle of text <0>:

Enter text: SIGLE TEXT1 

Enter text: 

Mtext d�_UÐ Multiline Text …dI	 jš
 lOD²�ðË ÆqOD²�L� ÎUHKÝ œb×ð  UŠU�� sL{ ‰Ë«b−�«Ë  «dIH�«Ë qL−�« WÐU²JÐ d�_« «c¼ p� `L�¹

 sL{ WÐU²J�« dNEð ÆdDÝ UN²×ð Ë√ WHK²�� WOB½ ◊UL½QÐ Ë√ WKzU� ◊uD�Ð  ULK� V²Jð Ê√ ◊UL½_« bŠ√ sL{

  Æ(Multiline text editor) Mtd�_« oO³D²� WI�«d� WOB½ WýUý



±∞± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫s¹—ULð
∫WO�U²�« ‰UJý_« rÝ—√

±

≤

≥



±∞≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫q¹bF²�«  «Ëœ√ j¹dý ∫f�U��« ”—b�«
  ¨rÝd�«  «Ëœ√ j¹dýË rÝd�« d�«Ë√ vKŽ ”Ë—œ s� o³Ý ULO� UM�dFð

 ÊuJL�«Ë Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý vKŽ ·dF²�« UM¼ ‰ËU×MÝ

 bŠ«Ë ÌwÝUÝ√ Ìd�√ vKŽ UM�dFð b
Ë Æ©≥∑≠¥® qJý Î̈UOÝUÝ√ Î«—“ ±∂ s� ÎUC¹√

 vKŽ ·dF²�« qLJMÝ ¨Êô«Ë Æ Erase szUJ�« ·cŠ u¼Ë q¹bF²�« d�«Ë√ s�

 Mirror  ”UJF½ù«Ë Copy a�M�U� œU�uðË√ w� …—uNAL�« q¹bF²�« d�«Ë√ WOIÐ

 Rotate d¹Ëb²�« rŁ Move p¹d×²�«Ë Array W�uHBL�«Ë Offset WŠ«“ù«Ë

 ¨Trim hI�« ¨Lengthen b¹bLð ¨Stretch jL�« ¨Scale rÝd�« ”UOI�Ë

  W¹Ë«eÐ VDA�« Break at point WDI½ w� lDI�« ¨Extend W�U×� b¹bL²�«

 ‰uB×�« sJL¹ UL� ÆExplode pOJHð rŁ Fillet  W�U×Ð d¹Ëb²�«Ë Chamfer

 Æ©≥∏≠¥® qJý ¨Modify WOÝUOI�« WLzUI�« s� d�_« «c¼ vKŽ

 Modify WOÝUOI�« WLzUI�« ∫©≥∏≠¥® qJý Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý ∫©≥∑≠¥® qJý

Copy  a�M�«
 v�≈ UNKLŠË t� W¾�UJ� wK�_« qJA�« s� Èdš√ W��½ ¡UA½≈ vKŽ d�_« «c¼ ÂuI¹

 Æ UOŁ«bŠùUÐ …œb×� l
«u� w� UNF{uÐ Ë√ rÝd�« WýUý vKŽ dIM�UÐ U�≈ Èdš√ l
«u�

 vKŽ ‰uB×�« sJL¹ UL� ©Co  dB²�� ÌqJAÐ Ë√  Copy V²�«® a�M�« d�√ q
=
F ÓHÔ½

ÆqÐUIL�« qJA�« w� UL� ¨ Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý s� d�_« «c¼



±∞≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Command: Copy 

Select objects: Specify opposite corner: 1 found         »uKDL�« qJA�« dI½« 

Select objects:               —UO²šô« W¹UN½

Specify base point or displacement, or [Multiple]: int 

Æt� ”UÝ√ WDI½ ÊuJð Ê√ w� Vždð w²�«Ë t��½ »uKDL�« qJA�«  w� ◊UIM�« bŠ√ dI½«

Specify second point of displacement or <use first point as displacement>: 

 Œu�ML�« qJAK� b¹b−�« l
uL�« dI½«

Copy a�M�« ∫©≥π≠¥® qJý

 Multiple Copy —dJ²*« a�M�«
 rŁ wK�_« szUJ�« s� …b¹bł a�½ ¡UA½≈ vKŽ ÂuI¹ Copy wK�_« d�_« s� wŽd� d�√ u¼ —dJ²L�« a�M�«

 ‰U¦L�« ÆwK�_« d�_« ‚UOÝ sL{ Multiple —dJ²� —UO��« qOFHð vKŽ d�_« «c¼ ÂuI¹ Æq�_« V½U−Ð UNIB�

   …—dJ²� a�½ ¡UA½≈ UMMJL¹ nO� `{u¹ w�U²�«

Command: Copy 

Select objects: Specify opposite corner: 1 found     »uKDL�« qJA�« dI½« 

Select objects:         —UO²šô« W¹UN½

Specify base point or displacement, or [Multiple]: M     —dJ²� —UO��« q
=
F ÓHÔ½

Specify base point: int

 wK¹ UL� ”UÝ√ WDI½ ÊuJð ÊQÐ Vždð w²�«Ë t��½ »uKDL�« qJA�« w�  ◊UIM�« ÈbŠ≈ dI½«



±∞¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Specify second point of displacement or <use first point as displacement>: 

 WÐU²� UNðUOŁ«bŠ≈ œbŠ Ë√ ÁöŽ√ ”UÝ_« WDI½ UNOKŽ o³DMð ÊQÐ Vždð w²�«Ë WýUA�« vKŽ  ◊UIM�« ÈbŠ≈ dI½«

 d�«Ë_« …c�U½ w�

Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�

Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�

Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�

Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�

Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�

Specify second point of displacement or <use first point as displacement>: ¡UN²½ö�

Multiple Copy —dJ²L�« a�M�« ∫©¥∞≠¥® qJý

∫‰U¦�

 rOI²�L�« j��« vKŽ tð«– qJA�« s� Èdš√ ‰UJý√ WFÐ—√ lMBð YO×Ð rÝd�« WýUý vKŽ ÎU�uÝd� ÎöJý a�½«

∫wðQ¹ UL� q×�«  Æ…bŠË ±μ W�U�� ÁbFÐ Ë√ tK³
 Íc�« sŽ sOFL�« qJA�« bF³¹ YO×Ð

Command: Copy 

Select objects: 1 found       t��½ »uKDL�« qJA�« dI½«

Select objects: 

Specify base point or displacement, or [Multiple]: M      —dJ²� —UO��« q
=
F ÓHÔ½

Specify base point:         Á ©tł—Uš v²Š Ë√® qJA�« w� WDI½ ÍQ� ”UÝ_« WDI½ œb×½

Specify second point of displacement or <use first point as displacement>: @15<0 

Specify second point of displacement or <use first point as displacement>: @30<0



±∞μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Specify second point of displacement or <use first point as displacement>: @45<0

Specify second point of displacement or <use first point as displacement>: @60<0

Specify second point of displacement or <use first point as displacement>: d�_« wNM½

Mirror  ”UJF½ù«
 ”UJF½ù« jš qJA¹ jš v�≈ ÎUÝUO
 t� W��UF� wK�_« qJA�« s� Èdš√ W��½ ¡UA½≈ vKŽ d�_« «c¼ ÂuI¹

 «c¼ vKŽ ‰uB×�« sJL¹ UL� ©Mi  dB²�� ÌqJAÐ Ë√  Mirror V²�«® ”UJF½ù« d�√ q
=
F ÓHÔ½ ÆMirror Line

Modify>Mirror WO�Ozd�« WLzUI�« s� v²Š Ë√ Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý s� d�_«

Command: Mirror 

Select objects: Specify opposite corner: 1 found  5         »uKDL�« qJA�« dI½«

Select objects:               —UO²šô« W¹UN½

Specify first point of mirror line:                     ”UJF½ô« j�� v�Ë_« WDIM�« s� —U²�½ 

Specify second point of mirror line:              ”UJF½ô« j�� WO½U¦�« WDIM�« s� —U²�½

Delete source objects? [Yes/No] <N>: q�_« ·cŠ w� p²³ž— ÂbF� ‰Ušœù« ÕU²H� jGC½

q³


bFÐ

Mirror ”UJF½ô« ∫©¥±≠¥® qJý

Offset WŠ«“ù«
 vKŽË q�ú� W¹“«u� szU� s� …b¹bł W��½ ¡UA½≈ vKŽ WŠ«“ù« d�√ √b³� ÂuI¹

 U�≈ WŠ«“ù« W�U�� b¹b×²� sO²O½UJ�≈ …œUF�UÐ Offset d�_« sL{ błu¹ ÆtM� œb×� bFÐ

V²�«® WŠ«“ù« d�√ q
=
F ÓHÔ½ ÆWýUA�« vKŽ …œb×� ◊UI½ sOÐ W�U�L�« b¹b×²Ð Ë√ ÂU
—_UÐ

 j¹dý s� d�_« «c¼ vKŽ ‰uB×�« sJL¹ UL� ©O  dB²�� ÌqJAÐ Ë√  Offset

Modify>offset WO�Ozd�« WLzUI�« s� Ë√ Modify Toolbar q¹bF²�«  «Ëœ√



±∞∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫‰U¦�

 s� …bŠË ∑∞ bFÐ vKŽË dLŠ_« ◊uD��« œbF²L� ÎU¹“«u� dš¬Ë ÍËUL��« ‚—“_« j�K� ÎU¹“«u� ÎUDš rÝ—«

Æ©¥≤≠¥® qJý ÆsOMŁù«

Command: O 

OFFSET

Specify offset distance or [Through] <50>: 70 

Select object to offset or <exit>:            Í©ÍËUL��« ‚—“_« j��«® q�_« dI½«

Specify point on side to offset:                     ©sOLO�«® WŠ«“ö� Áb¹dð Íc�« V½U−�« vKŽ WDI½ œbŠ

Select object to offset or <exit>:                         Í©dLŠ_« j��«® q�_« dI½«

Specify point on side to offset:             tM� Èd�O�« t²Nł w� WDI½ dI½«

Select object to offset or <exit>:  

q³
 bFÐ

WŠ«“ù« ∫©¥≤≠¥® qJý

 Move p¹d×²�«
 Â«b�²ÝUÐ dš¬ l
u� v�≈ w�U×�« UNF
u� s�  UMzUJ�«Ë d�UMF�« „d×ð Ê√ lOD²�ð œU�uðË√ w� pLÝ— bFÐ

 ∫WOðü« ‚dD�« ÈbŠ≈ d²š« p�cÐ ÂUOIK� ÆMove¢p¹d×ð¢ œU�uðË√ d�√

Æ©dB²�� qJAÐ m ® Ë√ Move  d�«Ë_« …c�U½ w� V²�«  

 Æq¹bF²�«  «Ëœ√ j¹dý s�  ¢ p¹d%¢ —“ d²š«  

 ÆModify>Move WOÝUOI�« WLzUI�« s� p¹d×²�« d�√ vKŽ ‰uB(« sJ1 UL�  

 dýRL�« —“ dI½« ¨d�«Ë_« …c�U½ w� Select object ¢ÎUMzU� d²š«¢ tłu� —uNþ bMŽË ¨ ôU×�« lOLł w�Ë

 szUJ�« Ë√ dBMF�« —UO²š« WOKLŽ ¡UN½ù  ‰Ušœù« ÕU²H� U¼bFÐ jG{« rŁ ÎUFDI²� `³BO� szUJ�« p�– vKŽ d�¹_«

 v�≈ szUJ�« «c¼ p¹d×²� UNO�≈ œUM²Ýô« UMMJL¹ w²�«Ë Base Point ”UÝ_« WDI½ UNL�½ WMOF� WDI½ œbŠ U¼bFÐË

 ∫w�U²�« q�K�²�« T�UJ¹ ULÐ tO�≈ tKIMÐ Vžd½ dš¬ ÊUJ�



±∞∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Command: Move 

Select objects: Specify opposite corner: 1 found

 ÆbŠ«Ë dBMŽ œb×ð tOKŽË UNKIM²Ý w²�«  UMzUJ�« œbŠ Í√

Select objects: 

  jG{« Ë√ ¨ÎUI�«u� sL¹_« …—QH�« —“ dI½« „d×²²Ý w²�«  UMzUJ�« ¡UI²½≈ WOKLŽ ¡UN²½« bMŽ

Specify base point or displacement:          WMOF� ”UÝ√ WDI½ dýRL�UÐ dI½«  
 WDIM�« ÁcN�  UOŁ«bŠS	 Ë√ dýRL�UÐ Î¡«uÝ WýUA�« vKŽ WDI½ œbŠ Í√

Specify second point of displacement or <use first point as displacement>:

 ÆUNðUOŁ«bŠ≈ Ë√ ¨”UÝ_« WDI½ tKB²Ý Íc�« b¹b−�« l�uL�« dýRL�UÐ dI½«

∫p¹d×²�« d�√ oO³D²� vK¦L�« WI¹dD�«
 q×ð WKJAL�« Ác¼ ÆMove p¹d×²�« d�√ cOHM²� ”UÝ_« WDI½ œb×¹ s¹√ b¹b×ð WKJA� Âb�²�L�« tł«uð

 w²�« Èdš_« WDIM�«  UOŁ«bŠ≈ b¹b×²Ð ÂuI½ rŁ s�Ë szUJ�« vKŽ WDI½ œb×ð –≈ ¨VŁu�« ◊UL½√ bŠ√ Â«b�²ÝUÐ

 ÆszUJ�« UN� qB¹ Ê√ V−¹

∫‰U¦�

 Æ…bŠË μ∞ W�U�� sOLO�« v�≈ ÎU�uÝd� ÎUFÐd� „dŠ

Command: Move 

Select objects: 1 found               lÐdL�« dI½« 

Select objects: 

Specify base point or displacement:

  lÐdL�« U¹«Ë“ ÈbŠS� ”UÝ_« WDI½ b¹b×²� © UMzUJ�« VŁË j¹dý s�® lÞUIð VŁu�« jL½ œbŠ

Specify second point of displacement or <use first point as displacement>: @50<0 

 ÆsOLO�« v�≈ …bŠË μ∞ W�U�� U�d×ð lÐdL�«Ë ”UÝ_« WDI½ Ê√ b−²�

Èdš√ WI¹dDÐ q×�«

Command: Move 

Select objects: 1 found                lÐdL�« dI½« 

Select objects: 

Specify base point or displacement:     WýUA�« vKŽ WDI½ W¹√ dýRL�UÐ dI½« 

Specify second point of displacement or <use first point as displacement>: @50<0 

ÆsOLO�« v�≈ …bŠË μ∞ W�U�� „d×ð lÐdL�« Ê√ b−ð



±∞∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ∫± `OLKð

 dýRL�UÐ U¼—UO²š« rð WýUA�« vKŽ WDI½ W¹√ d³²Fð –≈ Æ”UÝ_« WDI½ l
uL� oO
b�« b¹b×²�« w� m�U³½ ô Ê√ UMOKŽ

ÆÈdš√ …œb×� WDI½  UOŁ«bŠ≈ WÐU²� bMŽ ‰U×�« u¼ UL� ÎU�ULð b¹b×²�« ◊dA� WO�u²��

∫≤ `OLKð

 WŠ«“ù« Ë√ ”UÝ_« WDI½ b¹b×ð pM� VKD�«Ë dšü ÌÊUJ� s� UN�d×²Ý w²�« d�UMF�«ØdBMFK� „—UO²š« ‰UŠ

 szUJ�«ØdBMFK� „d×²�« W�U�� Í√ WŠ«“ù« —«bI� …dýU³� V²Jð Ê√ lOD²�ð Specify base point or displacement

 Æ”UÝ√ WDI½ w¼ UNO� Á—UO²š« rð w²�«Ë dBMFK� v�Ë_« dIM�« WDI½ Ê√ v�≈ Î«œUM²Ý«

 Rotate d¹Ëb²�«
  UMzUJ�«Ë d�UMF�« s� WŽuL−� W¹√ v²Š Ë√ szUJ�« Ë√ dBMF�« d¹Ëbð vKŽ d�_« «c¼ ÂuI¹

 Æ…œb×� q�√ WDI½ ‰uŠË WMOF� W¹Ë«eÐ

∫‰U¦�

 ÆP WDIM�« ¨tO� qzUL�« lKC�« nB²M� WDI½ ‰uŠ 
o
π∞ —«bILÐ —U�O�« vKŽ ÂuÝdL�« ·d×ML�« t³ý —

=
Ë Óœ

q³


bFÐ

 szUJ�« d¹Ëbð ∫©¥≥≠¥® qJý

Command: Rotate  (Ro )

ROTATE

Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0

Select objects: 1 found            Ád¹Ëbð »uKDL�« ·d×ML�« t³ý ¨dBMF�« dIM½

Select objects:      —UO²šô« WOKLŽ ¡UN½ù ‰Ušœù« ÕU²H� jGC½ 

Specify base point: mid  of        ”UÝ√ WDIM� ·d×ML�« t³ý w� qzUL�« j��« nB²M� œb×½

Specify rotation angle or [Reference]: 90 

 ÆWŽU��« »—UIŽ fJFÐ …—Ëœ lÐ— —«bILÐ P WDIM�« ‰uŠ ·d×ML�« t³ý —ËbO�



±∞π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

  Scale rÝd�« ”UOI�
 s� WŽuL−� W¹√ v²Š Ë√ dBMF�« ¨szUJ�« r−Š dOGBð Ë√ dO³Jð vKŽ d�_« «c¼ ÂuI¹

 Æ…œb×� WDI½ v�≈ W³�M�UÐ  UMzUJ�«Ë d�UMF�«

∫‰U¦�

 nBMK� …dz«b�« dG� bFÐ ULO� rŁ ¨PWDIM�« ‰uŠ 1.25 —«bIL�UÐ dLŠ_« ÊuK�UÐ ÂuÝdL�« ·d×ML�« t³ý d
Ò
³�

Æ·d×ML�« t³ý r−Š dOOGð ÊËœ U¼e�d� ‰uŠ

 ∫©¥¥≠¥® qJý

Command: Scale  (Sc )

Select objects: Specify opposite corner: 1 found    ·d×ML�« t³ý dIM½ 

Select objects:        d�UMF�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½

Specify base point:            P WDIM�« w¼Ë ”UÝ√ WDI½ œb×½ 

Specify scale factor or [Reference]: 1.25 

 ÆP WDIM�« ‰uŠ 1.25 W³�MÐ r�Cð b
 ·d×ML�« t³ý Ê√ b−M�

 s� u¼ UL� ·d×ML�« t³ý r−Š vKŽ ¡UIÐù« l� nBMK� C U¼e�d� ‰uŠ …dz«b�« U½dG� «–≈ ¨Èdš√ WNł s�

  ÆsOLO�« vKŽ Y�U¦�« qJA�« vKŽ qB×M� WIÐU��« W�U×�«

Command: Scale  (Sc )

Select objects: Specify opposite corner: 1 found              …dz«b�« dIM½ 

Select objects:         d�UMF�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½

Specify base point:            C …dz«b�« e�d� w¼Ë ”UÝ√ WDI½ œb×½  

Specify scale factor or [Reference]: 0.5 



±±∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Trim V¹cA²�«
 dBMŽ Trim ¢V¹cAð¢ d�_« cOHM²� d�u²¹ Ê√ V−¹ p�c� ÆtF� wI²K¹ dš¬ dBMŽ s� bz«e�« dBMF�« W�«“≈ u¼

 œU�uðË√ pM� VKD¹ ¢V¹cAð¢ d�_ „cOHMð ‰UŠ ÆCutting Edge lÞUI�UÐ ÁuŽbMÝË wK�_« dBMF�« w
ö¹ dš¬

∫wðü« ‰U¦L�« w� UL� bz«e�« dBMF�« b¹b×ð rŁ s�Ë lÞUI�« b¹b×ð

∫‰U¦�

     Æ…dz«b�« œËbŠ qš«œ ÍËUL��« ‚—“_« j��« lD
«

 

 ∫©¥μ≠¥® qJý

Command: Trim  (Tr )

Current settings: Projection=UCS, Edge=Extend

Select cutting edges                WFÞUI�« ·«u×�« œ ÒbŠ 

Select objects: 1 found          …dz«b�« d²š« 

Select objects:             d�UMF�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½

Select object to trim or shift-select to extend or [Project/Edge/Undo]:

 …dz«b�« qš«œ ‚—“_« j��« ¡eł dIM½

Select object to trim or shift-select to extend or [Project/Edge/Undo]: 

 Æ…dz«b�« qš«œ s� j��« lD
 r²O�

 Extend ¢œ«b²�«¢ d�_«
 ÆBoundary Edges œËb×�UÐ ÁuŽbMÝ dš¬ dBMŽ l� wI²KO� ÂuÝd� dBMF� œ«b²�« qLŽ vKŽ d�_« «c¼ ÂuI¹

 w²�« d�UMF�« b¹b×ð pM� VKD¹ rŁ œËb×�« Ác¼ b¹b×ð œU�uðË√ pM� VKD¹ ¢œ«b²�«¢ d�_ „cOHMð ‰UŠ ¨p�c�

∫wðü« ‰U¦L�« w� UL� U¼bL²Ý



±±± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫‰U¦�

ÆdLŠ_« ÊuK�UÐ sOD��UÐ WK¦LL�« œËb×�« v�≈ ÍËUL��« ‚—“_« ÊuK�UÐ Ídz«b�« ”uI�«Ë j��« b�

q³
 bFÐ

 ∫©¥∂≠¥® qJý

 

Command: Extend  : (Ex )

Current settings: Projection=UCS, Edge=Extend

Select boundary edges ...

   dýRL�UÐ dLŠ_« ÊuK�UÐ sOD��« dIMÐ VO−²�²� œ«b²�ô« œËbŠ b¹b×ð œU�uðË√ VKD¹

Select objects: 1 found

Select objects: 1 found, 2 total

Select objects: 

 p�c�Ë ¨ÁbLÐ Vždð Íc�« dBMF�« —UO²šUÐ œU�uðË√ VO−²�O� œËb×�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½

  ÆÎ«bŠ«Ë Î«bŠ«Ë ÍËUL��« ‚—“_« ÊuK�UÐ j��«Ë ”uI�« ·«dÞ√ dIM½

Select object to extend or shift-select to trim or [Project/Edge/Undo]: ÍuKF�« j��« ·dÞ dI½√ 

Select object to extend or shift-select to trim or [Project/Edge/Undo]: ÍuKF�« ”uI�« ·dÞ dI½√

Select object to extend or shift-select to trim or [Project/Edge/Undo]: wKH��« j��« ·dÞ dI½√ 

Select object to extend or shift-select to trim or [Project/Edge/Undo]: wKH��« ”uI�« ·dÞ dI½√ 

Select object to extend or shift-select to trim or [Project/Edge/Undo]:       ¡UN²½ö�

 ÆÁöŽ√ qJA�« w� UL� WÐuKDL�«  «œ«b²�ô« vKŽ qB×M�



±±≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Chamfer ¢VDý¢ d�_«
 Ë√ sOMzU� d�uð V−¹ ¨p�c�Ë ÆszUJ�« w� Èdš√ ·«uŠ ¡UMÐË U¹«Ëe�«Ë ·«u×�« lD
 vKŽ d�_« «c¼ ÂuI¹

 b¹b×ð œU�uðË√ pM� VKD¹ ¢VDý¢ d�√ cOHM²Ð ¡b³�« ‰UŠ ÆULNOKŽ Chamfer ¢VDý¢ d�_« cOHM²� s¹dBMŽ

 ∫wðü« ‰U¦L�« ÷dF²�M� ÆUL¼dI½ rŁ s�Ë WÐuDA� W�U×Ð ULNDÐ— »uKDL�« sOFKC�« vKŽ WŽuDIL�« rOI�«

∫©±® ‰U¦�

  Æ©¥∑≠¥® qJA�« vKŽ√ w� Line d�_UÐ ◊uD�� ÂuÝdL�« qOD²�LK�  ·«u×�« VDý√

Command: Chamfer 

(TRIM mode) Current chamfer Dist1 = 0, Dist2 = 0

Select first line or [Polyline/Distance/Angle/Trim/Method]: D VDA�«  U�U�� D —UO²šô« V²J½ 

Specify first chamfer distance <0>: 5         v�Ë_« W�U�L�« œb×½

Specify second chamfer distance <5>: 3           WO½U¦�« W�U�L�« œb×½

Select first line or [Polyline/Distance/Angle/Trim/Method]:    wI�_«Ø‰Ë_« lKC�« dIM½ 

Select second line:        wÝ√d�«Øw½U¦�« lKC�« dIM½

 ÆjI� …bŠ«Ë W¹Ë«“ t� X³Dý b
Ë qOD²�L�« vKŽ qB×M�

 ∫©≤® ‰U¦�

 Æ©¥∑≠¥® qJA�« qHÝ_« w� Polylines ◊uDš œbF²L� ÂuÝdL�« qOD²�LK� ·«u×�« VDý√

  UODFL�« UM¼ dOG²ð

Command: Chamfer 

(TRIM mode) Current chamfer Dist1 = 5, Dist2 = 3

Select first line or [Polyline/Distance/Angle/Trim/Method]: D VDA�«  U�U�� D —UO²šô« V²J½ 

Specify first chamfer distance <5>: 5        v�Ë_« W�U�L�« œb×½

Specify second chamfer distance <5>: 3          WO½U¦�« W�U�L�« œb×½

Select first line or [Polyline/Distance/Angle/Trim/Method]: P        ◊uD��« œbF²� —UO��« œb×½ 

Select 2D polyline:              »uKDL�« ◊uD��« bF²� dIM½ 

4 lines were chamfered



±±≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

bFÐq³


 ∫©¥∑≠¥® qJý

 ÆÁU¹«Ë“ lOLł X³Dý b
Ë qOD²�L�« vKŽ qB×M�

 Fillet ¢W	UŠ d¹Ëbð¢ d�_«
 s¹dBMŽ Ë√ sOMzU� d�uð V−¹ ÎUC¹√ UM¼Ë ÆU¹«ËeK� W¹dz«œ ·«uŠ qLŽ vKŽ Fillet ¢W�UŠ d¹Ëbð¢ d�_« ÂuI¹

 ”uI�« dD
 nB½ b¹b×ð œU�uðË√ pM� VKD¹ Fillet ¢W�UŠ d¹Ëbð¢ d�_« cOHM²Ð ¡b³�« ‰UŠ ÆœU�uðË√ w� ÁcOHM²�

 ∫wðü« ‰U¦L�« ÷dF²�M� ÆULNO�H½ sO²�U×�« b¹b×ð pM� VKD¹ rŁ w½«—Ëb�« s�d�« «c¼ qLF� »uKDL�«

 ∫©±® ‰U¦�

 Æ©¥∏≠¥® qJA�« vKŽ√ w� Line d�_UÐ ◊uD�� ÂuÝdL�« wÝ«b��« qJA�« ·«u×� Î«d¹Ëbð qLŽ√ 

Command: Fillet 

Current settings: Mode = TRIM, Radius = 100

Select first object or [Polyline/Radius/Trim]: r     …—ËbL�« W�U×�« dD
 nB½  R —UO²šô« V²J½ 

Specify fillet radius <100>: 10                dDI�« nB½ —«bI� œb×½

Select first object or [Polyline/Radius/Trim]:               v�Ë_« W�U×�« dIM½

Select first object or [Polyline/Radius/Trim]:               WO½U¦�« W�U×�« dIM½

Select second object: 



±±¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

q³
 bFÐ

 ∫©¥∏≠¥® qJý

 ∫©≤® ‰U¦�

 Æ©¥∏≠¥® qJA�« qHÝ√ Polygon d�_UÐ ◊uDš œbF²L� ÂuÝdL�« rE²ML�« ”b�L�« ·«u×� Î«d¹Ëbð qLŽ√

Command: Fillet 

Current settings: Mode = TRIM, Radius = 10

Select first object or [Polyline/Radius/Trim]: r      …—ËbL�« W�U×�« dD
 nB½  R —UO²šô« V²J½ 

Specify fillet radius <10>:          dDI�« nB½ —«bI� œb×½

Select first object or [Polyline/Radius/Trim]: P  Polyline        ◊uDš œbF²�   P  V²J½ 

Select 2D polyline: Select 2D polyline:     ”b�L�« w� W�UŠ W¹√ dIM½

6 lines were filleted

  Array ¢W	uHB�¢ d�_«
 w� a�M�« Vðd²ð YO×Ð a�½ …bŽ v�≈ dBMF�« a�½ vKŽ d�_« «c¼ ÂuI¹ ÆœU�uðË√ w� …—uNAL�« d�«Ë_« bŠ√

 —U�O�« vKŽ wÝ√d�« j�K� WLE²M� ¢WO³D
 W�uHB�¢ UMKLŽ wðü« qJA�« w� Æw³D
 jL½ sL{ Ë√ …bLŽ√Ë ·uH�

 s� W½uJ� WLE²M� W�uHB� UMKLŽ rŁ ÆWł—œ ≥∂∞ W¹Ë«e�« sL{ d�UMŽ W�Lš s� W½uJ�Ë C WDIM�« s� ÎU
öD½«

 ÆrK� ≥∞tOK¹ Íc�«Ë œuLŽ q� sOÐ W�U�L�« ÊuJð YO×Ð WO³DI�« W�uHBL�« ŸuL−LK� …bLŽ√ WFÐ—√Ë bŠ«Ë Ìn�



±±μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ∫©¥π≠¥® qJý

 —«u×�« lÐd� sL{ WÐuKDL�«  U½UO³�« ‰Ušœ≈ ‰öš s� r²¹ œU�uðË√ w� d�_« «c¼ cOHMð Ê√ d�c�UÐd¹b−�« s�

 ÆOk WI�«uL�« —“ vKŽ jGC�« rŁ Array



±±∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫s¹—ULð
ÆMirror ”UJF½√ q¹bF²�« d�√ rŁ ”uI�«Ë …dz«b�«Ë j)« rÝ— d�«Ë√ Â«b�²ÝUÐ w�U²�« qJA�« rÝ—√  ±

ÆTr d�_« Â«b�²ÝUÐ "UM�« qJA�« V¹cAð rŁ …dz«œ rÝd�« d�√ Â«b�²ÝUÐ WO�U²�« ‰UJý_« rÝ—√  ≤

81



±±∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 UMzUJ�« hzUBš  «Ëœ√ j¹dý ∫”œU��« ”—b�«
 VOðd²�UÐ w¼Ë hzUB��« s� WŽuL−� vKŽ Íu²×¹ ¨UN�uDÐË WýUA�« s� ÍuKF�« ¡e−�« w� j¹dA�« «c¼ ÊuJ¹

 ∫sOLO�« v�≈ —U�O�« s�

j��« Ÿu½ j��« pLÝj��« Êu� UI³D�«

 ∫©μ∞≠¥® qJý

 Layers  UI³D�«
 UNM�  …b??Š«Ë  q�  eOL²ð  YO×Ð  WHK²��   UI³Þ  ¡UMÐ  UN�öš  s�  sJL¹  j¹dA�«  s�  —U�O�«  vB
√  w�  błuð

ÆWI³D�« Ác¼ sL{ W�uÝdL�«  UMzUJ�«Ë ◊uD��« pLÝË ŸuM�« ¨ÊuK�« VKž_« vKŽ qLA²� WMOF�  UH�«uLÐ

Color j)« Êu�
 ÆÂb�²�L�« j��« Êu� b¹b×ð r²¹ ¡e−�« «c¼ w�Ë

                                  

 UI³D�«                                       j��« Êu�                             j��« Ÿu½                                         j��« pLÝ

 ∫©μ±≠¥® qJý



±±∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

    Linetype  j)« Ÿu½
 ‰ušb�« rŁ Other ¢p�– dOž¢ vKŽ jGC�« Ë√ W�b�M� WLzU
 s� Á—UO²šUÐ Âb�²�L�« j��« Ÿu½ b¹b×ð r²¹ tO�Ë

 Æ»uKDL�« j��« Load ¢qOL×ð¢ „UM¼ r²O� Linetype maneger ¢ UI³D�« d¹b�¢ —«u×�« ‚ËbM� v�≈

Lineweight j)« pLÝ
 ÆW�b�ML�« t²LzU
 s� »uKDL�« j��« W�ULÝ —UO²š« r²¹ tO�Ë

 ∫WEŠö�

 ÆtŽu½Ë tJLÝË t½uKÐ jš q� eOLM� ¨œb×� jš vKŽ WI³Þ q� Íu²×ð YO×Ð  UI³D�« ÂUE½ Â«b�²Ý« qCH¹

 UN�«b�²Ý« bMŽ wDFð ≤ WI³D�« ÆwzdL�« j��« q¦LO� ÎUJOLÝË ÎöB²� ÎUDš UN�«b�²Ý« bMŽ wDFð ± WI³D�« ¨‰U¦L�Ë

 wH�L�« j��« q¦LO� ÎUDÝËË ÎUFDI²� ÎUDš UN�«b�²Ý« bMŽ wDFð ≥ WI³D�« ÆÍe�dL�« j��« q¦LO� ÎUFO�—Ë ÎUFDI²� ÎUDš

 Æ«cJ¼Ë ÆÆÆ wzUA½ù« j��« q¦LO� ÎUFO�—Ë ÎöB²� ÎUDš UN�«b�²Ý« bMŽ wDFð ¥ WI³D�« ÆpL��« WOŠU½ s�

 ∫ÂU¼ tO³Mð

 vKŽ ÃËœeL�« dIM�UÐ sOF� ÌszU� hzUBš q¹bFð sJL¹

 Properties  ¢hzUBš¢  —«u×�«  lÐd�  dNEO�  t�H½  szUJ�«

 dIM�U� ¨«cJ¼Ë ÆWÐuKDL�« hzUB��«Ë  UH�«uL�« dOOGð r²O�

 XLÝ— UN½√ s³¹ rÝd�« WýUý vKŽ W�uÝd� …dz«b� ÃËœeL�«

 μ∞ U¼dD
 nB½Ë 200,100 WDIM�« w� U¼e�d� ÊuJ¹ YO×Ð

 ¨UNO� W�uÝdL�« WI³D�« ¨UNDO×� ¨UN²ŠU�� sO³¹ UL� ¨rK�

 Æ©μ≤≠¥® qJA�« dE½√ ¨ÆÆÆ j��« pLÝ ¨UN½u�

 Properties hzUB��« ¢—«u×�« lÐd�¢ ∫©μ≤≠¥® qJý



±±π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

s¹bF³Ð rÝ— W�—Ë vKŽ Íd²�Ëe¹_« rÝd�« ∫lÐU��« ”—b�«
 jL½ qOFHð ¨W¹d²�Ëe¹√ Ì U�uÝ— ÃU²½ô ‚dD�« qNÝ√ s�

 ¨©μ≥≠¥®  qJý  ¨  Isometric Snap  Íd²�Ëe¹_«  VŁu�«

Æ‚dÞ …bFÐ tOKŽ ‰uB×�« r²¹ Íc�«Ë

 WŁö¦�« W¹d²�Ëe¹_«  U¹u²�L�«Ë —ËU×L�« ∫©μ≥≠¥® qJý

 Ë√ ¨d�«Ë_« …c�U½ w� dsettings WÐU²JÐ  ±

 rŁ WOÝUOI�« WLzUI�« s� Tools ¢ «Ëœ√¢ —UO²šUÐ  ≤

¢rÝd�«  «œ«bŽ≈¢ —UO²š«

Tools>Drafting Settings   

 VKž√  W��ö�  bMŽ  dýRLK�  5LO�«  —e??�«  dI½  ≥

  «œ«bŽ≈¢ dI½ rŁ qHÝ_« w� W�U(« j¹dý —«—“√

ÆSettings ¢rÝd�«

Æ©μ¥≠¥® qJA�« w� Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� dNE¹ WIÐU��«  ôU×�« lOLł w�

 sL¹_« eO×�« w� Snap type & style ¢VŁu�«  jL½¢ rŁ Snap and Grid ¢WJ³A�«Ë VŁu�«¢ ÊU�K�« —U²�½

 —“ jGC½ rŁ Isometric snap ¢Íd²�Ëe¹√ jL½¢ UNKHÝ√Ë Grid snap ¢WJ³A�« jL½¢ „UM¼ œb×M� ¨wKH��«Ë

  ÆqHÝ_« w� Ok WI�«uL�«

Íd²�Ëe¹√ jL½

Drafting Settings  ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� ∫©μ¥≠¥® qJý



±≤∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 d�«Ë_« …c�U½ w� Snap d�_« WÐU²JÐ Isometric snap Íd²�Ëe¹_« VŁu�« jL½ vKŽ ‰uB×�« sJL¹ UL�

Command: snap

Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.000>: S

©Style —UB²š«® S V²J½

Enter snap grid style [Standard/Isometric] <S>: I   

©Isometric —UB²š«® I V²J½

Specify vertical spacing <10.000>: 

 d�_« WÐU²� Ë√ ¨Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� Â«b�²Ý« ¡«uÝ sO²IÐU��« sO²�U×�« w�Ë

∫WO�U²�«  UOF{u�« ÈbŠ≈ v�≈ ‰u×ð b
 dýRL�« Ê√ b−½  d�«Ë_« …c�U½ w� Snap

                        

Íd²�Ëe¹_« rÝd�« w� dýRL�« ‰UJý√  ∫©μμ≠¥® qJý

 bMŽË ÆsOFL²−� Ctrl+E  sOŠU²HL�«  jGC½ Ë√   F5  ÕU²HL�«  jGC½ dýRLK�  Èdš√Ë WOF{Ë sOÐ  qIM²K�Ë

 Ortho ¢b�UF²�¢ —UO��« Â«b�²ÝUÐ —uEMLK� …b�UF²L�« ÕuD��« ·«uŠ rÝdð Íd²�Ëe¹_« VŁu�« jL½ w� qLF�«

 ¨p�c�Ë ¨ÎUIÐUÝ  œ—Ë w²�« …dýU³L�« WI¹dD�UÐ ◊uD��« rÝ— r²¹ U¼bMŽË ¨Status bar ¢W�U×�« j¹dý¢ s�

 WOF{Ë Â«b�²ÝUÐ WO�U�_« ÕuD��« rÝdðË ¨sOLO�« vKŽ dýRL�« WOF{Ë Â«b�²ÝUÐ W¹uKF�« ÕuD��« ·«uŠ rÝdð

Æ©μμ≠¥® qJý ¨—U�O�« vKŽ dýRL�« WOF{Ë Â«b�²ÝUÐ WO³½U−�« ÕuD��« rÝdðË UL� ¨jÝu�« w� dýRL�«

∫©±® ‰U¦�

 ÆÎ«d²LOKO� 15x20x30 ÁœUFÐ√ Íc�«  öOD²�L�« Í“«u²� rÝ—«

  ∫©μ∂≠¥® qJý



±≤± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Ortho on b�UF²�« jL½ q
=
F ÓHÔ½

Æ1 WDIM�« sJ²�Ë dýRL�UÐ ‚öD½ù« WDI½ œb×M� ¢jš¢ d�_« Âb�²�½

 1 2 3 4  ULOI²�L�UÐ WK¦LL�«Ë  öOD²�L�« Í“«u²L� ÍuKF�« `D��« ·«uŠ rÝd�

 Y×L�« rIK½ rŁ ¨©2 WDIM�« ÁU−ðUÐ® sOLOK� dýRL�« „d×M� Isoplane Top WOF{u� qB½ v²Š F5 ÕU²HL�« jGC½

 Æ©μ∂≠¥® qJý ¨2 WDIM�« ZM²²� ¨≥∞ WLOI�UÐ

  ∫©μ∑≠¥® qJý

Æ3 WDIM�« ZM²²� ≤∞ rIK½Ë UNMOL¹ v�≈Ë 2 WDIM�« ÂU�√ dýRL�« l{u� dOG½

  ∫©μ∏≠¥® qJý

 vKŽ qB×M� rÝd�« oKG½ rŁ Æ4 WDIM�« ZM²²� ¨≥∞ rIK½Ë U¼—U�¹ v�≈Ë 3 WDIM�« ÂU�√ dýRL�« l{u� dOG½ rŁ

  Æ öOD²�L�« Í“«u²L� ÍuKF�« `D��«



±≤≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

  ∫©μπ≠¥® qJý

 Isoplane Right WOF{u� qB½ v²Š F5 ÕU²HL�« jGC½ 3 4 6 5 w�U�_« `D��« ·«uŠ rÝd�

 Æ5 WDIM�« vKŽ qB×M� rK� ±μ W�U�LÐË qHÝú�Ë 3 WDIM�« s� ÎU
öD½« wÝ√d�« j��« rÝd½

 Æ6 WDIM�« vKŽ qB×M� ≥∞ rIK½Ë qHÝ_«Ë —U�OK� dýRL�« l{u� dOG½

Æ©μπ≠¥® qJý ¨ 4 WDIM�« v�≈ qBM� ±μ rIK½Ë 6 s� ÎUDš rÝdM� vKŽú� dýRL�« l{Ë dOG½

  ∫©∂∞≠¥® qJý

Isoplane Left WOF{u� qB½ v²Š F5 ÕU²HL�« jGC½ 1 4 6 7 w³½U−�« `D��« ·«uŠ rÝd�

  Æ1 WDIMK� qB²� rK� ±μ —«bIL�UÐ vKŽú� dýRL�« l{u� dOž rŁ rK� ≤∞ —«bIL�UÐ ÎUDš —U�OK�Ë 6 WDIM�« s� rÝ—«



±≤≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

Isometric circles Íd²�Ëe¹_« …dz«b�« —uEM� rÝ—
 rŁ  Isocircle ¢…dz«b�« —uEM�¢ —UO²š« rŁ Ellipse ¢h
U½ lD
¢ d�√ Â«b�²ÝUÐ W¹d²�Ëe¹_« dz«Ëb�« rÝdð

ÆW¹d²�Ëe¹_« …dz«b�« dD
 nB½ —«bI� Y×L�« w� rIK½

∫©≤® ‰U¦�

10,30 WDIM�« U¼e�d�Ë μ∞ U¼dD
 nB½ w²�« ÍuKF�« `D��« w� Íd²�Ëe¹_« …dz«b�« —uEM� rÝ—«

Command: El 

ELLIPSE

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I 

Specify center of isocircle: 10,30 

Specify radius of isocircle or [Diameter]: <Isoplane Left> <Isoplane Top> 50 

  Isoplane Top ÍuKF�« `D��« WOF{Ë v�≈ UMK�Ë v²Š F5 ÕU²HL�« UMDG{ dDI�« nB½ —«bI� rOIKð qO³
Ë UM½√ kŠö½

  ∫©∂±≠¥® qJý



±≤¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

∫©≥® ‰U¦�

 Æ©∂≤≠¥® qJý ¨V�dL�« —uEML�« rÝ—«

  ∫©∂≤≠¥® qJý

 Isopalne Top  Ê√ s� b�Q²½Ë  Ortho on b�UF²�« jL½ q
=
F ÓHÔ½

Æ«cJ¼ UNO�≈ Î«œuŽË A WDIM�« s� ÎU
öD½« ©WŽU��« »—UIŽ l�® ABCDE ÍuKF�« `D��« ·«uŠ ÎôË√ rÝd½

Command: L 

LINE Specify first point:             A WDIM�« œbŠ 

Specify next point or [Undo]: 40         40  V²�√ rŁ A s� —U�OK� dýRL�« ‰uŠ

Specify next point or [Undo]: 100       ∫sO³�u¼ UL� lÐUð rŁ

Specify next point or [Close/Undo]: 80 

Specify next point or [Close/Undo]: 70 

Specify next point or [Close/Undo]: C 

Æ©∂≥≠¥® qJA�« vKŽ qB×M�

  ∫©∂≥≠¥® qJý



±≤μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ◊uD��« bŠ√ rÝ— sJL¹® ÆrK� ≤∞ —«bILÐË qHÝú� B Ë D ¨ E¨ A ◊UIM�« s� WOÝ√— ◊uDš WFÐ—√ rÝd½

  Æ(Copy a�M�« d�√ Â«b�²Ý« rŁ s�Ë

  ∫©∂¥≠¥® qJý

Æ©∂μ≠¥® qJý ¨◊uD�Ð ◊uD��« Ác¼ ·«dÞ√ q�u½ rŁ

  ∫©∂μ≠¥® qJý



±≤∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 sOFÞUI²L�« sO¹e�dL�« sOD��« rÝdÐ p�–Ë A B C D E `D��« vKŽ W¹dz«b�« W½«uDÝ_« …bŽU
 —uEM� e�d� œb×½

ÆW½«uDÝô« …bŽU
 —uEM� rÝd½ ¨tOKŽ

Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I 

Specify center of isocircle:           ÍuKF�« `D��« w� sO¹e�dL�« sOD��« lÞUIð dIM½

Specify radius of isocircle or [Diameter]:  <Isoplane Top> 25        dDI�« nB½ ≤μ V²J½

  ∫©∂∂≠¥® qJý

 Æ…dz«b�« Í—uEML� sOÝUL� sODš rÝd½Ë ¨Copy d�ô« Â«b�²ÝUÐ rK� ≤∞ W�U�� vKŽú� …dz«b�« —uEM� a�M½

  ∫©∂∑≠¥® qJý



±≤∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 Æ©∂∏≠¥® qJA�« w� »uKDL�« —uEML�« vKŽ qB×M� rÝd�« w� bz«Ëe�« V¹cA²� Trim d�ô« Âb�²�½

  ∫©∂∏≠¥® qJý

 WEŠö�

 ‚dD�« s� ÌÍQÐ Rectangle snap wI�_« Èu²�L�« sL{ ÍœUF�« rÝd�« jL½ v�≈ WE×� W¹√ w� Ÿułd�« sJL¹

 Æ”—b�« W¹«bÐ w� WŠËdAL�« WŁö¦�«

 Æd�«Ë_« …c�U½ w� dsettings WÐU²JÐ  ±

Tools>Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —UO²š« rŁ WOÝUOI�« WLzUI�« s� Tools ¢ «Ëœ√¢ —UO²šUÐ  ≤

ÆSettings ¢rÝd�«  «œ«bŽ≈¢ dI½ rŁ qHÝ_« w� W�U(« j¹dý —«—“√ VKž√ W��ö� bMŽ dýRLK� 5LO�« —e�« dI½  ≥

 Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� dNE¹ WIÐU��«  ôU×�« lOLł w�

 ¨wKH��«Ë sL¹_« eO×�« w� Snap type & style¢VŁu�«  jL½¢ rŁ Snap and Grid¢WJ³A�«Ë VŁu�«¢ ÊU�K�« —U²�½

  ÆqHÝ_« w� WI�«uL�« —“ jGC½ rŁ Rectangle snap¢ÍœUŽ jL½¢ UNKHÝ√Ë Grid snap¢WJ³A�« jL½¢ „UM¼ œb×M�



±≤∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

ÆœU�uð_« Z�U½dÐ Â«b�²ÝUÐ WOðü« ‰UJý_« rÝ—« ∫ s¹—ULð
 ©±® s¹d9

 ©≤® s¹d9



±≤π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©≥® s¹d9

 ©¥® s¹d9



±≥∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©μ® s¹d9

 ©∂® s¹d9



±≥± œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©∑® s¹d9

 ©∏® s¹d9



±≥≤œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©π® s¹d9

 ©±∞® s¹d9



±≥≥ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©±±® s¹d9

 ©±≤® s¹d9



±≥¥œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©±≥® s¹d9

 ©±¥® s¹d9



±≥μ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©±μ® s¹d9

 ©±∂® s¹d9



±≥∂œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©±∑® s¹d9

 ©±∏® s¹d9



±≥∑ œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©±π® s¹d9

 ©≤∞® s¹d9



±≥∏œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©≤±® s¹d9

 ©≤≤® s¹d9



±≥π œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

 ©≤≥® s¹d9

 ©≤¥® s¹d9



±¥∞œU??�u??ðË_U??Ð r??Ýd??�« ∫W??F??Ð«d??�« …b??Šu??�«

lł«dL�« WLzU�
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